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« A global semiconductor leader

&WhO IS ST

R
Y e,

- 2017 revenues of $8.35B with year-
on-year growth of 19.7%

« Listed: NYSE, Euronext Paris and
Borsa ltaliana, Milan

=

® Research & Development
® Main Sales & Marketing
® Front-End

® Back-End

*  Approximately 45,500 employees worldwide

r « Approximately 7,400 people working in R&D
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- 11 manufacturing sites . )"

«  Over 80 sales & marketing offices

As of Deé:ember 31, 2017



ST. Products & Ecosystem
to Match IoT Market Trends

Smart Smart Smart
Things 2, Home City

Ultra-low power, Form Wifi, BTLE, sub-GHz,
Sensors, Audio, Touch,
Graphics...

LTE, Sub-GHz, Motion Longevity, Certification,
Sensors motion sensors...

Factor, Sensors
Performance...

Market Trends

Broad Technology Offer A Ecosystem for application development

Secure

STM32 Nucleo
expansion boards
for connectivity,
sensing, actuating

o NFc))) 0 N é,_’ ‘ cory L8 .
e . | -as 5'}'1'-132 ¢=m||'|
g @ = % e E Starter Kits and 'e Envirahment

ST Offering

Move/
Actuate

G ' .
(] ) STM32 Nucleo Form Factor Boards
development kits
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The IoT Trend =

Any system able to leverage the Internet and its ecosystem

L |
Eig
") e

Analytics

Nodes
(Billions)

Smart

Things

Applications
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Gateways
(Millions)

Gateway

Smartphone

Storage

Cloud

Servers
(Big data & cloud)

Network infrastructure
(Switch / Router)




loT Devices Come in Many Form Factors
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@ﬁ ..but Their Needs are the Same ==

Sensing & Processing Connectiv Signal Conditioning
Actuating & Security y & Protection

s N
Smart —
Things 1 I
\_ y,
s ~ Ultra-Low Power
45> Smart Full range of
N Home : . t0 Nano Amps
\ J Sensors High Performance
r ~ to
and :
Smart | Kilo Amps
City actuators Scalable Security
> - solutions
s N
l_, Smart
FE Industry ()

- J
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MEMS and Analog Empower the 0T ==
e (N @ ||

) @ || @ .

Sense Actuate Sensor Power Signal Connectivity Security Processing
Interface Conditioning

MEMS Digital
.
Sensors

Today only a tiny portion of the sensory data that would be useful is captured, stored and analyzed

—
i ol
1]
T

...and even smaller part of that is used to carry out actions through actuators
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Actuate @@
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Secure

Process

Sense
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Supporting the loT Movement

4]
SensorTile

STM32 Nucleo Development
& Expansion boards

Pre-integrated SW for vertical applications

Smart Things Smart Home Smart City Smart Industry

Development Ecosystem

® @ ®

Code generators  Prototyping Development
software environments
Debug Simulation On-line

solutions and analysis tools  design tools

ST
Community
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Supporting the loT Movement

4]
SensorTile

)

STM32 Nucleo Development
& Expansion boards

Pre-integrated SW for vertical applications

Smart Things Smart Home Smart City Smart Industry

Development Ecosystem

AlgoBuilder

ST
Community
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ST as Sensors & Actuators Supplier

St

&“gnsa%

19

_BILLION

"

@

Market-proven Manufacturing High Volume Expertise in Leading Smart | Key Partnerships
Technologies Manufacturing multi-sensor Functions In product
Front-End / Back-End/ Testing & Calibration |ntegrati0n |ntegraﬂ0n development
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20 Years of MEMS at ST

| ! !
Accelerometer Inertial Pressure Micro-mirror Piezo Water Proof
module sensor actuators actuators Pressure
\
‘ﬂ sensor
g 208
Fluidic Gyroscope Magnetometer Microphone Humidity GAS &VOC
Micro-actuators sensor
2000 2005 2010 2017 2018

0\ O o o o o (] O O O O

Smart Things Smart Home & City Smart Driving

-
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-
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Advanced Industrial Sensors

10-Year Product Longevity

000

Industrial Appliances Building Medical Defense Navigation
automation

/ ST Longevity Program Benefits \

EXTENDED
10-YEAR DESIGN AND CALIBRATION & TEMPERATURE

LONGEVITY FROM MANUFACTURING TESTING FOR RANGE AND
PRODUCT FOR HIGHER HIGHER ENDURANCE TO

SHOCK AND

INTRODUCTION ROBUSTNESS & ACCURACY &
DATE PERFORMANCES QUALITY VIBRATION
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STM32 portfolio positioning

12 product series / More than 800 Parts

Ultra-low-power @

. / ! .5'.°~ s’y
Wireless
N R ST S S More than
 Cortoxmoy COTEXM3[  CortexMa Cortex-M7 40,000 customers

"I Note ®: Cortex-MO+ Radio Co-processor
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Supporting the loT Movement

4]
SensorTile

STM32 Nucleo Development
& Expansion boards

Pre-integrated SW for vertical applications

Smart Things Smart Home Smart City Smart Industry

Development Ecosystem

® @ ®

Code generators  Prototyping Development
software environments
Debug Simulation On-line

solutions and analysis tools  design tools

ST
Community
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HW Development Tools

Evaluation STM32 Nucleo

STM32 Nucleo Discovery kits )
boards expansion

Third-party boards

Flexible Key feature Full feature Functionality From full evaluation to open
prototyping prototyping evaluation add-on hardware

www. st.com/stm32nucleo www.st.com/stm32discovery Www. st.com/stm32evaltools www.st.com/x-nucleo
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http://gnbproject7mms.gnb.st.com/mcdmktg/regions/ecosystem/Ecosystem Branding Visuals/Hardware/module_NUCLEO_STM32.png

An Application-Oriented Approach

Processorboards (Nucleo 64) Function Packs (FP)
Expansion boards (X-NUCLEO)

Your need

Sensors
,ﬁ Connectivity

=3 Translate

Op Amp
Motor controller

(ﬁ?@ Motor drivers

Processing

Application software Integrated Development Environment Ready-to-use
and development tools and middleware application-oriented package
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Development Software Architecture

Mobile app prototyping & cloud prototyping

Sample applications | Function Packs

é & “Quj STM32Cube expansion SW °

% | ég 3! STM32Cube High-value middleware - -..‘ SDTel\*fé?gp?n%iq
' SEZ middieware STM32Cube . Environment
S8

STM32Cube

Hardware Abstraction Layer (HAL)

STM32 Nucleo STM32 Nucleo
Development boards Expansion boards
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Development Software Architecture

Mobile app prototyping & cloud prototyping

N Sample applications | Function Packs Using AlboBulder
23 | _
2 ouw | STM32Cube expansion SW L @

1 é £ <:§ STM32Cube High-value middleware ﬁ
i B—g GE) E middleware STM32Cube Sensor and Audio Algorithm Software
288! Expansion HAL
o5 |

STM32Cube

Hardware Abstraction Layer (HAL)

STM32 Nucleo STM32 Nucleo
Development boards Expansion boards
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http://www.st.com/resource/en/user_manual/dm00373531.pdf
http://www.st.com/resource/en/user_manual/dm00372763.pdf
http://www.st.com/resource/en/user_manual/dm00382798.pdf
http://www.st.com/resource/en/user_manual/dm00382798.pdf
http://www.st.com/resource/en/user_manual/dm00382798.pdf

Existing algorithms
User-defined data processing
blocks
Additional functionalities
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Code &
generation :
ST
X, :fiy' ‘t:'

GUI quickly elaborates proto applications
for
MEMS sensors
and
STM32 microcontrollers

AlgoBulilder

An application for the graphical design and testing of algorithms

AlgoBuilder
eases the process of
implementing
proof of concept
without writing the code


http://www.st.com/resource/en/user_manual/dm00373531.pdf
http://www.st.com/resource/en/user_manual/dm00372763.pdf
http://www.st.com/resource/en/user_manual/dm00382798.pdf

AlgoBuilder Overview
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DEVELOPMENT BOARD

AlgoBulilder

Overview

=]

Seectports |cOMG Connect 5" Discommect st @stp | sengs | Xomat

Fie Edit View Fimware Tools Help

0 BB A

o X £3 ot Found

— | "% “C ‘®

]_aaQa

Comparson
Constants

Display

Graphics

Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID
MotionMC
MotionPW

Other

Sensor Hub

Signal
Termperature

User Input

Vector Operations

Free Fal Detectar

- - T Logic
/ / SN

Acceleration
[al

/

<

Description &8 X

[Sensor Hub]

Version: 1.0

Sensor Hub provides links to sensor and algorithms in order
to retrieve data from them.

‘Output Pins:
out (void x 1):
Sensor Hub handler.

Properties:
Data Rate (int):
Defines the sensor's and algorithm’s data rate in Hz.
Range: <1, 400>
Accelerometer Full Scale (int):
Defines the accelerometer ful scale.
Values: 16 g, 29,4 g, 89
Gyroscope Full Scale (int):
Defines the gyroscape full scale.
Values: 1000 dps, 2000 dps, 245 dps, 500 dps

Console

Properties & x
Hame Value Type
Data Rate 100 INT

Accelerometer Ful Scale ENUM
Gyroscope Full Scale | 500 dps | Enum

x: 479.6 y: 49.5 zoom: 0.908091

GRAPHIC DESIGN

Info  FWManagement  User Messages  IKSO1A2 Options

Wamiel | ¥ emisl | 7 eaisies anl bales mad
Datalog @l g1l g 10 ms] |
o sl o samel  Genal 6o o
h -0.005000 | 0.0070001 1.0140001 0ol ol
o Tatienl  oocamcl el ool ol
Zooosoool  olcososol  1cicanol o ol ol

Taosenl  oocomcl  ieinecl 0ol ol

Zolcosoool  olcososol  1lcicanol ol ol

looesenl  alcomscol  ilcisenol o o) ol

Zooonoool  olcososol  iicizenol ol ol

Tooomoonl  alcomscel  ilcisenol ool ol

Zooosoool  olctoosol  iicizenol ol ol

loesenl  alcimocel  ilcisenl ool ol

Zooonoool  olcosonol  1icizenol ol ol

Zooomoenl  acomscel  ilcizanl o ol ol

Zocosoool  olcamosol  iicirenol ol ol

looesoenl  olcomscol  icisanol ool ol

Zoooroool  olcososol  1icisenol ol ol

Tooomenl  ocomscel  iicisenol ool ol

Zooosoool  olotiosol  ilcroonol ol ol

looenoonl  alcomcel  iciesnol o ol ol

Zootooool  olcomosol  iicisenol ol ol

Tooosoanl  alcomscel  ilciasnol o ol ol

Zoloooool  olcamosol  1icisenol G ol ol

Zooamoonl  ocamocol  ilcizenol o ol ol

2

Acceleration:
My |

1[a]

0.5[q]

|
rbzt-wv-”*'-u

(+) - Joospad g |

Int32 and Float Values:
Pulse Width 0 [ms]

RESULT




AlgoBuilder

Overview

AlgoBuilder is an application for the graphical design of algorithms.

The main objectives of this application are:
*  Quick prototyping of applications for STM32 microcontrollersand MEMS sensors which include already existing algorithms (i.e.
sensor fusion or pedometer), user-defined data processing blocks and additional functionalities.
» Ease the process of implementing proof of concept using graphical interface without writing the code.
*  Visualize the data on Unicleo-GUIlin real time using plot and display.

 The main feature of this application:
« Simple graphical design (drag and drop, connect, set properties)
« A wide range of function blocks are available in libraries including motion sensor algorithms.
« Customize function blocks. Open XML for function blocks and design storage.
* C code generated from the graphical design.
» Supportfor various compilers: SW4STM32 (GCC), IAR EWARM, Keil uVision.
« Outputs from generated firmware can be displayed in Unicleo-GUIlapplication.

Lys
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AlgoBuilder

Principle

AlgoBuilder 1. Make your design

GUI
AMEData™ conversion
Engine
C code 3. Uploads to your
development board
l NUCLEO
<%

FwTemplate IR EIIEEIESS R Compiler i _
Project ‘ D - Unicleo-GUI

n € 4R el

ibrari 2. AlgoBuilder compiles
L(L,iﬂr'e)s your design through
4 external compiler

7

4. Display sensor
data in Unicleo-GUI

Lys
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Environment Setup
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Prerequisites: Software

 AlgoBuilder: Application for the  AlgoBuilder uses external compiler
graphical design of algorithms to build the FW.
It is mandatory to have available at least one of
: the IDE if you want to compile a project.
* Unicleo-GUI Y PIE & Pro)
The Unicleo-GUIl is used to display outputs » Supported IDEs
fromthe running FW generated by the System Workbench for STM32 v1.13.1 or
AlgoBuilder 9 newer

SIAR . |AR EWARM 7.80.4 or newer

STM32 ST-LINK utility

DIKEIL « Keil uVision 5.22 or never

STM32 Virtual COM Port Driver

Lys
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Unicleo-GUI
X-CUBE-MEMS1 &=

Key features:

» Display output data from connected sensors in various views (X-NUCLEO-IKS01A1, X-NUCLEO-IKS01A2)
» Display outputs from algorithms

« Save data to comma separated (CSV) or tab separated (TSV) files

« Configure sensor output data rate and full scale

» Direct read from and writes to sensor registers

* Program NUCLEO board with selected FW

& Unicleo-GUI - X b Unicleo-GUI - X
Select Device: |COM6 :) ¥ Connect p‘Diswnnect I P Start Stop | .4 Settings | K Exit Select Device: |BCH-002 (C0:23:32:A3:72:40) :I JConnect 5" Disconnect | I Start Stop | ;2 Settings | X Exit
Info FW Management User Messages IKS01A2 Options Info FW Management User Messages
DEB — Accelerometer - LSM6DSL —— Pressure - LPS22HB e el =
< . . Firmware Description: .
Enable: Address: - Enable: Address: - ,
& 2 [0 TR TION £ Accelerometer Calibration Y u YO 2 @® ® 3
Moiie Eull Scale:[8 = Value:,ﬁv of € ¢ | Eull Scale: 5 Value:l__]v O — 1KS01AZ 1KS01AZ 1KS01AZ 1KS01A2 1KS01A2 IKSO1A2 IKSO1A2 IKSO1A2
MEMS 3 Acceleromete  ActiveTime_| AdtivityReco AdtivityReco CamryPositio  DatalogExten  DatalogExten  DatalogFusio
2.10 a
ODR:|416 ~ Get Set ODR:|75 52 Get Set rCalibratio K501AZbin gnition_IKS gnitionWris  n_KS01A2b  ded IKSO1A2  ded XTI_IKS  n_IKSO1A2b
& Set) G &) E&D 7 Library Version: n_KS01A2.b 0142.bin t_IKS01AZb in bin 01A2.bin in
Enviz- ST MotionAC v2, 1.0 n n
_— Gyroscope - LSM6DSL Humidity - HTS221 Expansion Board:
S E IKS01A2 E
nable: Address: - Enable: [J Address: v <
Scatter Mucleo Board: (\ =N - e
Full Scale:|1000 :I' Value: :l' Full Scale: :lv Value: :I' STM32L475RG 1KS01A2 1KS01A2 K501A2 1KS01A2 1KS01A2 K501A2 Ks01a2 K50142
ODR:[416 ~ ODR:[125 ~ ECompass [KS  FallDetectic  FFT_.Demo.bin  FitnessActiv  GestureRecog  GyroscopeCal  IntensityDet  Magnetometer
Get) [ Set) J D Get) (set) ) Main function is to show how to use 01AZ.bin n_IKSOTAZb ities_IKSO1 nition_IKs0 ibration_IK ection_IKSO Calibration
X_MNUCLEOQ_IKS01A1(2) expansion board for in A2.bin 1A2.bin 501A2.bin 1A2.bin _IKS01AZ.bi
demonstration of accelerometer calibration. n
~—— Magnetometer - LSM303AGR — Temperature - HTS221 ——
2 i ~ : g >
Enable: 4 Address it Enable: [J Address
4
Full Scale:|50 ® Value: - o Full Scale: ¥ Value: v
9000000000000060606060 IKS01A2 IKS01A2 1KS01A2 1KS01A2 1K501A2
ODR:|50 :]v ﬂset) _Set) P e oeeovneeseess ODR:|12.5 :lv Get .Set) ) Pedometer IK  PedometerWri  PoseEstimati standingsSitt TiltSensing_
= — S01A2.bin St_IKSO1AZ. on_KSOTAZ.  ingDesk KS  IKSO1AZ.bin
ucteo Lrive bin bin 01A2.bin
Enable All Sensors Disable All Sensors
Mucleo Drive Mot Found -
~ -
STMicroelectronics Unicleo Version: 1.4.2.5856 Firmware Version = 4.0.0 Expansion Board: IKS01A2 STMicroelectronics Unicleo Version: 1.4.12.6746 Firmware Version = v0.0.0 Expansion Board:

Lys

life.augmented



augmented

Autoscale is ON

Clear Lines

+400mG

+300mG

+200mG

+100mG

-100mG

@® Sensor Fusion 9x

2000 mg

1000 mg

X-CUBE-MEMS1

Vertical Context Plot

-4000(

0
I
Data Valid: 1
Vertical Context: Escalatc
Context Confidence: Poor

Time

09:39:44.09
09:39:50.07
09:39:54.07
09:39:55.96
09:40:01.92
09:40:04.13
09:40:22.12

Fitness Activities

Activity
Biceps Curl
Biceps Curl
Biceps Curl
Squat
Squat
Push-up
Push-up

15000 cm

14000 cm

200 cmfs

ggunter Current Activity:

g; Push-up
00 Count: 01
03

00

01

O Sensor Fusion 6x Reset model |




Prerequisites: Hardware

Nucleo Development & Expansion Sensor Tile
Boards
- NUCLEO-F401RE or NUCLEO-L476RG » The development kit simplifies prototyping,
evaluation and development of innovative
» X-NUCLEO-IKS01A2: Motion MEMS and solutions.

environmental sensor expansion board for
STM32 Nucleo

SensorTile kit o7
Connectable sensor node "

life.augmented



Motion MEMS and environmental sensor expansion board

X-NUCLEO-IKS01A2 Hardware Description

* The X-NUCLEO-IKS01A2 is a motion MEMS and environmental
sensor evaluation board system.

* It is compatible with the Arduino UNO R3 connector layout, and is
designed around ST's latest sensors.

’

~0bbs i B-AYD

Liec-1l

o i,

Key Product on board

MEMS 3D accelerometer (+2/+4/£8/£16 g) + 3D gyroscope
(x125/+£245/+500/+1000/+2000 dps)

)|
®
®
®
®
®
®
®
®
©
©
®
®
L]
®
|®
®
®

(A A X ENXEXEEXXEK XXX XXX

MEMS 3D magnetometer (50 gauss) + MEMS 3D accelerometer

(£2/+4/+£8/+16 Q)
‘q-sms se7[iEi] L A

- [CsB14  ses[d] $

MEMS pressure sensor, 260-1260 hPa absolute digital output barometer N | reeo-Teor Aba v - )
ST morpho connector**
Capacitive digital relative humidity and temperature D HTS221 LSMBDSL _ P
Socket available for additional MEMS adapters and other sensors (UV index) [[]LPs22HB [ ] LSM303AGR [_] Arduino UNO R3 connector
D DIL 24-pin

\
Latest info available at www.st.com
"I X-NUCLEO-IKS01A2 )

life.augmented ** Connector for the STM32 Nucleo Board




SensorTile Platform

STEVAL-STLKTO01V1 Hardware Description

« STEVAL-STLKTO1V1 is the development kit for the SensorTile board (STLCS01V1), a highly Integrated Development
Platform with a broad range of functionalities aiming to improve system design cycle and accelerate delivery of results

SensorTile Cradle expansion
SensorTile Core System STLCX01V1
STLCS01V1 Antenna = N

13.5mm
< > Clearance Area
- . . g | /\
Digital Mic
L BALF-NRG-01D3
STM32L476 E
vy -
u :
~ o
v

SensorTile Cradle
STLCRO1V1

LSM303AGR LPS22HB

Lys
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AlgoBuilder

1. Run install.bat as administrator Installation
a | = | Application Tools 04 - O ket
Haome Share View Manage ~ o
o - Cut = New item + 4 [@E] Open Select all
E «® X=f 332 &
w.| Copy path ﬂ Easy access ~ D Edit 0 Select none
Pinto Quick Copy Paste - Move Copy Delete Rename Mew Properties . .
access El Paste shortcut tow to- - folder - 42 History EE‘In\rert selection
Clipboard Organize New Cpen Select
&« “ A e v USB_DISK (D) v | O Search USB_DISK (D:) »
Mame Date modified Type Size
# Quick access
data 5/31/2018 10:06 AM  File folder
I3 This PC documents /31/2018 10:10 AM  File folder
[ Desktop _inztall.bat Eatch File 2KB
Documents _uninstall.bat Ed'_t Batch File 1KB
i
; Downloads @ !nstall_swdstmil_w!n_izb p— n 452,226 KB
. @ install_swdstm32_win_g4b) n 448211 KB
J’ Music Q Run as administratar I}
[&] Pictures 7-Zip >
B Vvideos CRC SHA >
=, Windows (C) [ Edit with Notepad++
. USBE_DISK (D) Eﬂ Scan with Windows Defender..,
= DATA (\\gnx5949.gnb.st.com) () Secan for Viruses...
= AMSDATA (\\gnx3849.gnb.st.com) (L) A Convert with PDFCreator
= PR1 (\\gnx5%49.gnb.st.com) (W) ﬁ TortoiseSVN >
= p_memsdocs (\\ctofs00Ba.cto.st.com) (V) @ WinMerge
== Superisory (\\agrfs004b.agr.st.com\prg_ams\aoclab\Projects) (Z:)
Send to >
- USB_DISK (D:)
Cut
Q MNetwork Copy
Paste
Create shortcut
Delete
Rename
Properties
Gitems 1 item selected 1.46 KB

life.augmented



_
Installation

2. Confirm Device Drivers installation.

Device Driver Installation Wizard Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some

uters devi d in arder to wark.
COMPLISTS EEVICES NSSC N orasrio we The drivers were successfully installed on this compiter.

You can now connect your device to this computer. § your device
came with instructions, please read them first.

Driver Mame Status
%" STMicroelectronics (Win... Feadyto use

%" STMicroelectronics {usb... Readyto use
To continue, click Mea.

ack I Cancel

Cancel

[us]
51}
g
LY

Thiswill install ST-Link and Virtual Com Port Drivers.

Lys
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3. Remove USB and open C:/AlgoBuilderinstall/folder.
Runinstall sw4stm32 win 64bits-v2.4.exe as administrator.

AlgoBuilder

Installation

= | Application Tools

Home Share View Manage

C\AlgoBuilderlnstall

U o Cut x IEE T New item ~ [ open ~ [ select all
w-| Copy path « ﬂ Easy access = [ Edit 0 Select none
Fin to Quick Copy Paste _ Move Copy Delete Rename Mew Properties
access E Paste shortcut tow tow - folder - &£ History E‘E'In\rert selection
Clipboard Organize Mew Open Select
&« v > This PC » Windows (C:) » AlgoBuilderlnstall »
=
MName Date modified Type Size
7 Quick access
data 6/14/2018 5:30 PM File folder
B3 This PC docurnents 6/14/2018 5:30PM  File folder
] Desktop _install.bat 6/14/2018 458 PM Windows Batch File 2KB
Documents _uninstall.bat 5/30/2018 248 PM  Windows Batch File 1KB
* Downloads @ install_swdstm32_win_32bits-v2.4.exe 5/11/2018 3:30 PM Application 452,226 KB
J’ Musi £z} install_swAstm32_win_64bits-v2.4.exe 3/11/2018 3:50 PM  Apolication 449,211 KB
usic
Open
Pict
] Pictures Q Run as administrator I}
B Videos Troubleshoot compatibility
= RS Pin to Start
- WSB_DISK (D2) T-Zip >
= DATA (\\gnx3948.gnb.st.com) () CRC SHA >
= AMSDATA (\V\gnx3349.gnb.st.com) (L) (& Edit with Notepad++
= PR1 (\gnx5849.gnb.st.com) (W:) Ea Scan with Windows Defender...
=% p_memsdocs (\\ctofs00Ba.cto.st.com) (¥3) Scan for Viruses...
== Superisory (\\agrfs004b.agr.st.com\prg_ams\aoclab\Projects) (Z:) ﬁ TortoiceSYN >
= USB_DISK (D) ¥ WinMerge
I_j‘ Metwork Pin to taskbar
Restore previous versions
Send to >
Cut
Copy
’l Create shortcut
Delete
life.augmented R
ename
Gitems  1item selected 438 MB

s T

v & Search AlgoBuilderlnstall 2




AlgoBuilder

4. Executetheinstall sw4stm32 win 64bits-v2.4.exe as administrator
and confirmdefault settings.

Installation

G Installation of SystemWorkbench - [m|

Please read the following information:

About Sysvem Werkbench for STMIZ

System Workbench for STMIZ - Bare Metal Edition iz an Eclipse
i IDE. It prevides a s=fow devel latform for yous
STM3Z beard. The IIE helps you to guickly czeate a C cmbedded projecs
for your targes. It also integrases a complete code ediser,

lati i1 iles, linkes...) tocls and

zemcte-debugging seols.

The followi are i

System
Workbench

aCo

tool=s

in System for STMIZ -
Baze Metal Edision :

- STM3Z Devices databaze and librazies

- Scurce code editer

- Linker scrips generator

- Building tecls (G0C-based cross compiles, azsembles, linkes)

- Debugging teels (OpenOCD, GIE)
- Flaszh programing tecls I}
- Documentation
Zyztem for STMIZ iz tible with Eclipse swsended

features such az Subversive.

The IDE allows yeu to cazily czeate a project and componenss for the
device. To quickly build it and genezase the ILF file, binary. To
debug the project, System Workbench for STMIZ provides a debug

£: ien so do the with ST-Lizk/VZ o debug on chip.

© Quit

0 Installation of SystemWorkbench - |

Please read the following license agreement carefully:

0

End-Uzer License Agreement for AcE Spztem Workbench(TH)
Softwaze Development Tools

(Bew. Z014-07-07)
THIS EWD USER LICENSE AGHEEMENT ("LICEWSE") IS A LEGAL MCOEEMEWT EETWEEW YOU (EITHER A SINGLE

INDIVIDUAL, OB SINCLE LECAL ENTITY) KD ACE SAAL ("Rc6”) FOR THE USE OF THE SOFTWANE
ING THIS LICENSE. ACE IS ONLY WILLING TO LICENSE TEE SOFTWRRE TO YOU OF CONDITIOR

System
Weorkbench

aCo

tool=

THAT ¥OU ACCEPT ALL OF TEE TEAMS IN THIS LICEKSE. EY CLICKING "I MEDEE" OR EY INSTALLING OR
OTHERWISE USING OR COPYING THE SOFTWARE ¥OT INDICATE THAT YOU RGREE TO EE BOUND BY ALL TEE
TEPME OF THIS LICENSE. IF ¥OU DO KOT AEREL TO THE TERMS OF THIS LICEWSE, RC06 IS UWWILLING TO
LICENSE THE SOFTWANE TO ¥OU- DO KOT DOWNLOAD, INSTALL, USE, OB COPY THE SOFTWRRE.

E " meansz any zoftw £ and data thir Licenze, any documentation
supplied with it, and any Updates, in all cazes relating te the Acf package of zoftware
develepmens tools. The package i the Spztem for STMIZ i devel
envizonment [IIE) with build sools, i i1 ler, linkes, librazies and

example code. For convemience, your package alse includes, or allow you to download, Separate
Files (defined below in Clause € and alse referzed Se a "MCU Fimwaze®), bus these aze
licenzed under their own terms and not a= part of the Sofowaze.

"Szat” means the autherization from Acf, as evidenced in the zales ozdes, delivery
confirmation email and License Hey izsued to you by Acf, o uze and run cestain compoments or
features of the Scftwaze, omly in the guantities and for the time perieds stated therein, and
[if applicable) only with the target devices, and only in the countszies or geogzaphic

(®) I accept the terms of this license agreement. I

(0) I do not accept the terms of this license agreement.

@ Previous o Quit

G Installation of SystemWorkbench

& - o

) Please read the folowing license agreement carefully:

EINARY CODE LICERSE FOR
Java SE RUNTIME ENVIRCRMEFT (JRE) VERSION &

ACE IS WILLING T DELIVER TO YOU THE SOFTWARE (AS DEFIKED BELOW), WHICE IS LICEWSED EY ORACLE
AMERICA, INC. FOR AWD ON EEHALF OF ITSELF AND ITS SUBSIDIARIES AND AFFILIATES UNDER COMMON
CONTROL (“CBACLE®), ONLY UBCN THE CONDITION THAT ¥OU ACCEPT ALL OF THE TEDMS CONTAIKED IN
TEIZ EINARY CODE LICENSE AGDEEMEWT INCLUDING THE RESTRICTIONS AND ENCEPTIONS SET FORTH IN THE
SOETWANE DEADME FILE AWD THE SUPFLEMENTAL LICEKSE TERME (COLLECTIVELY THE "AGHEEMENT™) 8 IF
¥OU EAD PROCURED YOURSELF THE SOFTWARE DIRECTLY EROM OBACLE. PLEASE RERD THE AGREEIMENT EELOW

System
Workbench

aCo

tool=s

CRBEFULLY. BY SELECTING THE "ACCEET LICENSE AGDEEMEWT" (OR THE EQUIVALENT) BUTTON AND/CR BY
USING TEE SOFTWARE ¥OU ACHWOWLEDGE THAT ¥OU HAVE READ THE TEBMS OF THIS ACHEEMENT AND AGEEE
TO TEEM. IF ¥OU ANE AGREEING TO THESE TEEMZ ON EEHALF OF A COMPANY OB LEGAL ENTITY, ¥OU

THAT ¥OU HAVE THE LEGAL AUTHORITY TO BIND TEE LEGAL ENTITY TO THESE TERMS. IF ¥OU
DO KOT HAVE SUCH AUTHORITY, OB IF ¥oU DO HOT WISH TO EE BOUMD EY THE TEDMS OF THIS ACHEEMENT,
THEW SELECT TEE "DECLINE LICENSE ACHEEMEWT™ (0N THE EQUIVALEWT) EUTTON KD YOT MUST HOT USE
TEE SOFTWARE OF ANY MEDIX ON WEICE THE SOFTWHARE IS CONTAINED AND ¥OU MUST PROMTLY RETURE THE
TKUSED SOFTWRRE TO ACE.

DISCLAIMER OF WRRRANTY. THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WRRRANTY OF ANY KIND. RCE
DISCLAIM ALL WANNANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATICN, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITHESS FOR A PARTICULAN ETRECSE ON HONINFRINCEMENWT.
LIMITATION OF LIMEILITY. IN KO EVENT SHALL AC6 EE LIAELE FOR ANY INDIRECT, INCIDEFTAL,
SPECTAL, PUNITIVE OR COMSEQUENTIAL DAMACES, OR DAMACES FOR LOSS OF PROFITS, BEVEWUE, DATA or
DATX USE, INCURNED EY ¥OU OR ANY THIRD PARTY, WHETHER IN XN ACTION IN CONTAACT OR TCRT, EVEN
IF € HAS EEEN ADVISED OF TEE POSSISILITY OF SUCE DAMAGES. RCE'= ENTIRE LIABILITY ECR
DEMRCES HEREUWDER SHALL IN KO EVENT ENCEED ONE THOUSAND DOLLARE (U.5. $1,0000.

(@) I accept the terms of this license agreement.l

(0) I do not accept the terms of this license agreement.

@ Previous o Quit
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AlgoBuilder

Installation

o Installation of SystemWorkbench

“TRAL B o

System

Workbench Select the installation path:

|C :‘l,AcG‘\SystEmWarld:enm|

" Emwse...

<3 Previous

O Installation of SystemWorkbench

8% Selact the packs you want to install:
@ Mote: Grayed packs are required.

em Workbench for STM32

[#] ST-Link/v2 driver (required for proper operation) 6.03MB
[] STlinkServer 723.7KB
]
it .n NaeA e
System
Workbench
Description
System Workbench for STM32
Total space Required: 493.58 MB
Available space: 112.55GB

| @Erevious

Qoit |

o Installation of SystemWorkbench -

[%] Setup Shortcuts

[ Create shortruts in the Start-Menu
[+ Create additional shortcuts on the desktop

. Select a Program Group for the Shortcuts:

S 7-Zip

Accessories

Administrative Tools

Altium

Altium Designer &

Autonomy

Cisco

doxygen

Git b

Waorkbench

(Default) A create shortout for:

() current user
Accessibili

Systam v (@) all users

|SyshemWorld)end’1 |

<3 Previous Next

Qait |

> /4
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AlgoBuilder

Installation

& Installation of SystemWaorkbench - [m| X
Installation will proceed with the Following settings. Press Mext ko continue.
Installation Path
C\AcH\SystemWorkbench?
Chosen Installation Packs
o) System Workbench for STM32
' ST-Link/V2 driver (required for proper operation)
. A e STLinkServer
System
Workbench
<3 Previous € quit

> /4
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AlgoBuilder

5. Execute SWASTM32, set the Workspace directoryto the default options, Installation
then closethe application.

3C6

tools

Workbench
STM32

Rt/ & - linea
= Workspace Launcher >

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: “ V| | Browse...

[] Use this as the default and do not ask again

m ok | Cancel

life.augmented




AlgoBuilder

Installation

6. Check that following applications were installed on your PC:

v AlgoBuilder v2.0.0

v Unicleo-GUI v1.5.0

v STM32 ST-LINK Utility

v System Workbench for STM32 (AC6)

life.augmented
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AlgoBulilder

[£] Alge Builder GUI - MyExample_T.ml

Fle Edit Wiew Frmware Tools

Library

Help

g X

Comparison
Constants
Display

Graphics

Logic Operators
Math Operations
MotionAwW
MotionFx
MotionGC
MotionID
MotionMC
MotionPW
Other

Sensor Hub
Sequential Logic
Signal

User Input
Vector Operations

WOW W W W W W W W W W W W W W W WY

Library

Menu & Toolbar -0
O . ¢ —
'5@}'&)\&@@ ‘jc’lb.ébl | L1 8 & CcC e #NotFound vﬁ@
Description F X
[Sensor Hub]
Version: 1.0
Sensor Hub provides links to sensor and algorithms in order
to retrieve data from them.
Qutput Pins:
out (void x 1): B I O C k
WO r kS aC e Sensor Hub handler.
p Properties: D p
Data Rate (int): eS C r I tl O n
Defines the sensor's and algorithm's data rate in Hz.
Range: <1, 400>
Accelerometer Full Scale (int):
Acceleration Defines the accelerometer full scale.
e | [a] IR Values: 2q, 449,80, 169
Gyroscope Full Scale (int):
Defines the gyroscope full scale.
Walues: 245 dps, 500 dps, 1000 dps, 2000 dps
Properties F X
Narme Value Type
Data Rate 100 INT
Accelerometer Full.. |4 g ~ | ENUM
Gyroscope Full Scale | 500 dps w | ENUM
Console 8 X

Console

(Errors, Warnings, Other information)

Block
Properties

‘ ’I X: 649 y: 89 zoom: 1
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Display:

Several options can be used to display output data.

[£ Custom Fields Plot N o |- )
Properties & X
Properties g x
Name Value Type
Mans Value Type Mumber of Channels 4 INT
SLTEPIRE mer o INT Channel 1 Name Sw 1 STRING
Graph Name Arbitrary Float ... STRING Graph 1 Channel 2 Name Sw 3 —
Waveform 1 Name Float 1 STRING Channel 3 Name Sw 3 STRING
Waveform 2 Name  Float 2 STRING Channel 4 Name S 4 STRING
Waveform 3 Name  Float 3 STRING Channel 5 Name STRING
Waveform 4 Name  Float 4 STRING Channel 6 Name STRING
Waveform 5 Name STRING Channel 7 Name STRING
Waveform 6 Name STRING Channel 8 Name STRING
Unit Mame STRING
Graph 2 Properties 8 x
Properties g X | h Name Value Type
Name Value Type Number of Values 4 INT
Mumber of Values 4 INT Value 1fiame Int 1 STRING
Value 1 Name Float 1 STRING Value 2 Tiame Int 2 STRING
Value 2 Name Float 2 STRING Value 3 Name Int 3 STRING
Value 3 Name Float 3 STRING Value 4 Name Int 4 STRING
Value 4 Name Float 4 STRING Value 5 Name STRING
Value 5 Name STRING Value 6 Name STRING
Value 6 Name STRING Logic Value 7 Name STRING
Value 7 Name STRING Analyzer Va!ue 8 Name . STRING
Value 8 Name STRING Unit 1 Name Unit 1 STRING
Unit 1 Name Unit 1 STRING Unit 2 Name Unit 2 STRING
Unit 2 Name Unit 2 STRING Unit 3 Name Unit 3 STRING
uUnit 3 Name Unit 3 STRING Unit 4 Name Unit 4 STRING
Unit 4 Name Unit 4 STRING Unit 5 Name STRING
Unit 5 Name STRING Unit 6 Name STRING
Unit 6 Name STRING Unit 7 Name STRING
Unit 7 Name STRING 1 Unit 1 Float 1 1.100000 Unit 1 Unit 8 Name STRING
Unit 8 Name STRING 2 Unit 2 Float 2 2.200000 Unit 2 Value
Value 3 Unit 3 Float 3 3.300000 Unit 3 (Int)

’ (Float) 4 Unit 4 Float 4 4.400000 Unit 4 |
‘ ’ [

augmented




Graph - Displays data as a time graph

Graph
[ Acceleration O x
Acceleration:
Properties 5 X
Marme Value Type
Number of Curves 4] INT
Graph Mame Graph STRING
Vaveform 1 Name Javeform 1 STRING
Waveform 2 Name Waveform 2 STRING
Vaveform 3 Name faveform 3 STRING
Vaveform 4 Name faveform 4 STRIMNG
Vaveform 5 Name faveform 5 STRIMNG
Vaveform & Name Javeform & STRIMNG
Unit Mame STRIMNG
Zero axis position Middle ~ | ENUM &
Auto-scale OFF w [ENUM =l 4]
Full Scale 1 STRING

Lys

augmented



Logic Analyzer - Displays logic signals which can have values only O or 1

Logic
g Analyzer
Properties B X
Marme Value Type
Number of Channels 8 INT
Logic Analyzer Name Logic##Analyzer STRING
Channel 1 Name chi STRING
Channel 2 Name ch2 STRING
Channel 3 Mame Ch3 STRIMNG
Channel 4 Mame Ch 4 STRIMNG
Channel 5 Mame Chs STRING
Channel & Mame Che STRING
Channel 7 Mame Cch? STRING
Channel 8 Mame chs STRING

msg/s = 101.8

DN @ @ @ @ @ 5

Lys
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Bar Graph - Displays actual value as bar

E»Herph [z Acceleration ] e
Properties F X
Marme Value Type
Mumber of Bars 6 INT
BarGraph Mame BarGraph STRING
Bar 1 Mame Bar 1 STRING
Bar 2 Mame Bar 2 STRING
Bar 3 Mame Bar 3 STRING
Bar 4 Mame Bar 4 STRING
Bar 3 Mame Bar 3 STRING
Bar & Mame Bar 6 STRING
IInit Name STRING
Zero axis position Middle ~ | ENUM
Auto-scale OFF ~ | ENUM
Full Scale 1 STRING

Lys
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Histogram - Displays values distribution

P Histogram
Properties f X
Marme Value Type
Histogram Mame Histogram STRIMG
UInit Mame STRIMG
MNumber of Intervals 10 INT
Zero axis position Middle EMUM
Auto-scale OFF EMUM
Full Scale 1 STRING

il Histogram

0.5 1]

Interval Start: 0.1 Interval End: 0.2

0.5

Count: 350 15.87 %




Scatter - Displays X,Y,Z data in 2D X-Y, X-Z, Y-Z chart

»¢* Magnetic Field | x
| Scatter
-f0mGE -60mG -50mG -40mG -30m ImE |0G +10mG +20mi +30r
+30 MG
Properties F X +20mG
MName Value Type
Size of Input 3 INT +10mG
Scatter Name Scatter STRING
Value 1 Mame Value 1 STRIMG
Value 2 Mame Value 2 STRIMG
Value 3 Name Value 3 STRING -10 més
Unit Name STRING e
Auto-scale OFF | ENUM L
Full Scale 1 STRING P Rin

430 mG

-40 miG

-50 mG

-60 mG

Lys
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3D Plot - Displays X,Y,Z data in 3D chart

I Plot3D
Y axis [uT]

Properties g X
Mame Value Type

Plot Mame 3D Plot STRIMG

Value 1 Mame Value 1 STRING

Value 2 Mame Value 2 STRING

Value 3 Mame Value 3 STRING

IInit Mame STRING

Auto-scale OFF ~ [EMUM

Ful Scale 1 STRING

Autoscale is OFF Clear Points

Lys
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AlgoBulilder

Fusion - Displays quaternion data as teapot 3D model.

.' FIJSIOH | @ Sensor Fusion o

Properties & X

Marme Value Type
Window Mame SensorF#Fusion STRING
Model Mame Teapot ~ | ENUM

Reset model

Lys
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Value - Displays the exact float or integer value

Value
Properties g X
Marne Value Type

Mumber of Values 8 INT

Window MName Values STRING
Value 1 Mame Value 1 STRING
Value 2 Mame Value 2 STRING
Value 3 Mame Valug 3 STRING
Value 4 Mame Value 4 STRING
Value 5 Mame Valug 5 STRING
Value &6 Mame Value 6 STRING
Value 7 Mame Value 7 STRING
Value 8 Mame Value 8 STRING
Unit 1 Mame Unit 1 STRING
Unit 2 Mame Unit 2 STRIMNG
Lnit 3 Mame Unit 3 STRIMNG
Lnit 4 Mame nit 4 STRIMNG
Lnit 5 Mame Lnit 5 STRIMNG
Lnit & Mame Unit & STRIMNG
Unit 7 Mame Unit 7 STRIMNG
Lnit & Mame Unit 8 STRIMNG

0.007000 [g]

0.000000 [g]

1.020000 [g]




User Input: AlgOBL“lder

Three types of data can be sent from Unicleo-GUI to running firmware: Binary, Integer and Float.
Input blocks can be used in the design to allow user interaction with the running firmware.

Input Value Input Value Input Value
(int) (Fioat) (Birar)

Properties F X Properties 5 ® Properties g X
Mame Value Type Name Value Type Name Value Type
Window Name Integer Values  STRING Window Name Float Values STRING Window Name Binary Values STRING
Mumber of Values 4 INT Mumber of Values 4 INT Mumber of Values 4 INT
Default Value 1 0 INT Default Value 1 0 FLOAT Default Value 1 1] T
Default Value 2 ] INT Default Value 2 0 FLOAT Default Value 2 0 NT
Default Value 3 ] INT Default Value 3 0 FLOAT Default Value 3 1] INT
Default Value 4 0 INT Default Value 4 0 FLOAT Default Value 4 0 INT
Value 1 Name Value 1 STRING Value 1 Name Value 1 STRING Value 1 Name Value 1 STRING
Value 2 Mame Value 2 STRING Value 2 Mame Value 2 STRING Value 2 Name Value 2 S5TRING
Value 3 Name Value 3 STRING Value 3 Name Value 3 STRING Value 3 Name Value 3 STRING
Value 4 Name Value 4 STRING Value 4 Name Value 4 STRING Value 4 Name Value 4 STRING
/=] Integer Values Pl || Float Values w /| Binary Values X
Value 1 0 | Value 1 0 | Value 1
Value 2 [ | Value 2 o |
Value 2
Value 3 [ | Value 3 [ |
Value 4 0 | Value 4 [ | value 3
‘ ’I Value 4
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User Input:
Input blocks can be used in the design to allow user interaction with the running firmware.
Input Value
(Int}
Input Value & Unicleo-GUI I =nEc] @l}
Binal Select Port: | COM3  Conmect ¥ Disconnect > Start Stop -7 Settings X Bt Properties g X
ry p
| Info I FW Management | User Messages | GENERIC Options MName Value Type
Properties T X ig . Mumber of Values 4 INT
Name Value Type Custom Bit Values Custom Int32 Values Default Value 1 1 NT
Mumber of Values 4 NT ?om - IValue 1 1 Default Value 2 2 INT
Default Value 1 1 INT  |ids Default Value 3 3 INT
Default Value 2 0 INT Walue2 2 Default Value 4 4 INT
Default Value 3 0 INT Value 1 Name Value 1 STRING
Default Value 4 i INT Walue 3 3 Value 2 Name IValue 2 STRING
Value 1 Name Switch 1 STRING Value 3 Name Value 3 STRING
value 2 Name Switch 2 STRING _Swich 4 | e L Value 4 Name Walue 4 STRING
Value 3 Name Switch 3 STRING U A
Value 4 Name Switch 4 STRING n I
Custom Float Values Input Value
Fvalue 1 1.1 (Float)
Fvalue2 2.2 Properties g X
FVakee 3 33 MName Value Type
Mumber of Values 4 INT
O R v Default Value 1 [ad FLOAT
Default Value 2 2.2 FLOAT
Default Value 3 3.3 FLOAT
STMicroelectroics Uricleo Version: 1.3.6.4363 Firmware Version = 4.0.0 Expansion Board: IKS01A2 Default Value 4 4.4 FLOAT
Value 1 Name Fvalue 1 STRING
Value 2 Name Fvalue 2 STRING
Value 3 Name Fvalue 3 STRING
Value 4 Name Fvalue 4 STRING

Lys
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New Features v1.5 - v2.0
FFT analysis, FFT plot, Window, Peak detection in frequency spectrum

Real ODR measurement for accurate FFT analysis

New example for FFT analysis
- ol = b =i FFT Plot |
| [Sensor Hub] F bl Acce[lsg:aatlon | De(;l}z:tgﬂ : — -
Y a2 ; g
P o FFT N
> FFT B
.
Z ax :
Properties g X W
Mame Value Type
Data length 1024 ~ |[EMUM
Window Type Mone ~ [EMUM
) FFT X axis [} b4

Amplitude [mg]

Data length: 32, 64, 128, 256, 512, 1024
Window: Hanning, Hamming, Flat Top

Output Data Rate: Magnitude: 2g
" ’ FFT Samples: Display Mode: Bars
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AlgoBuilder
New Features v1.5 - v2.0
Multi level design

Possibility encapsulate part of the design into one function block,
which can be saved into a library to be reused many times

Main design

Subdesign 1 »| RadToDeg F
Subdesign 2

/

Subdesign 1 : : ;
Subdesign 2 T Vg iy
= =5 o

™ o

180 + ! 3.14159 + J
Subdesign 3 L Lo

Lys
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New Features v1.5 - v2.0

Loops (for, while)

For Loop - is subdesign intended for loop, which is used if number

of iteration is known before entering the loop
While Loop - is subdesign intended for loop, which is executed until

a defined conditionis valid

h

Input Terminal
Subdesigns F x Buffer "
(Float) out F " . — I
X ) > {Flozt)

Fitcer: |

IFarLoopTemplate ;’r
1Subdesign Template Cycle [ |
I'WhileLoopTemplate Index I._ _-'
FirstSubdesign — FB P !
IntensityClasification (Float)
RadToDeq
SumBuffer
Wariance Cycle | 5 Cydle

Count Count

i] > Break
(Int) Condition

Lys
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sesign Rules: AlgoBulilder

Several rules must be kept during project design to create project which could be validated and compiled.
« Connection can be made between input and output of different function blocks
» Itis impossible to connect two inputs or two outputs together

« Only input and output of the same type can be connected, exception is variant input which will get the type of
connected output

* Only input and output of the same size can be connected together. Some inputs and outputs can have
variable size. Size value can be changed inside properties window. The size of input or output can be seen in
the description window when the block is selected.

» For clarity the thickness of the connection line indicates the size of input and output and color of the
connection line indicated the type (default: green —float, blue — integer, violet — other).

* All inputs must be connected

Function Blocks

| [Sensor Hub] F—. Acce[lgliation F—P Graph 1 |
\7K Connections/(/

m Input - Output Input - Output
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[E] Algo Builder GUIF - 0 x
File Edit View Firmware Tools Help

o Q@0 BMXIESTL & G horond - i ©
+1 Open Design ctrk0 Description g X
3 Save Design Ctrl+S
[%  save Design As . . . . .
1. Select Application Settings in File menu.
/~  Application Settings N
@ network Update Settings
4 e [£] aApplication Settings X
MotionGC
e Unicleo-GUI Path
> MotionMC ) . ’ - - -
» MotionPV |C.jProgram Files (x86)/STMicroelectronics/Uniclea-GUT/ Uniclen-GUL exe || Browse |
> Other System Workbench for STM32 Path
> Sensor Hub
> Sequ?antialLogic |C:jAcEanystemWorI{benchfecIipsec.exe || Browse |
> Signa
> User Input IAR Embedded Workbench Path
» Vector Operations | || B |
rowse

Keil uvision Path

| || Browse |

Fitter Build Qutput

Font Size: oK || Cancel | Properties =) &

MName Value Type

2. Enter the path to Unicleo-GUI
C:/Program Files (x86)/STMicroelectronics/Unicleo-GUl/Unicleo-GUIl.exe

3. Enter the path to selected IDE
e C:/AC6/SystemWorkbench/eclipsec.exe R

4. Click OK

" ¥ -136 y: 26 zoom: 1
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Algo Builder GUI* - O x
9

git  View Firmware Tools

h;@ﬁae\”@\@\ coBEXI-STL %% Yl v

i 28 Description 5 X

Comparisan

Constants 1 H
= Click on New Design
Graphics

Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID
MotionMC
MotionPW

Other

Sensor Hub
Sequential Logic
Signal

User Input
Vector Operations

WOWOW WOV W W W W W W W W W W W W

Properties g X

MName Value Type

Console 8 X

'l ¥ -119 y: 134 zoom: 1

life.augmented



> /4

[E] Algo Builder GUIF

Library

Fle Edt View Firm

BAR £ eaaaoc B Xl

vare  Tools  Help

F X

| 7 O o - b E

— | % "C 'O

Comparisan
Constants
Display

Graphics

Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID
MotionMC
MotionPW
Other

Sensor Hub
Sequential Logic
Signal

User Input
Vector Operations

WOWOW WOV W W W W W W W W W W W W

[£] Firmware Settings

Firmware Location

et
1. Browse for C:\AlgoBuilder\MyExample 1

|C:jhlg oBuilder/MyExample_1

|| Browse |

Toolchain / IDE

SW4STM32

- 2. Select compiler SW4STM32

Target

NUCLEO-L476RG

"‘ | oK || Cancel |

3. Select Target NUCLEO-L476RG

4. Click OK

dire

Console

x
Description g X
ctory
Properties g X
MName Value Type

¥ -119 y: 134 zoom: 1
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[E] Algo Builder GUI - * - 0 x
File Edit View Firmware Tools Help

AR A aaaaieoe BE X/I= aTTL %% O orons - I E

Library &F X Description g X

> Comparison

» Constants

v Display
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int)

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX %

MotionGC . . .

NotonID Expand Display and Sensor Hub libraries

MotionMC

MotionPW

Other

Sensor Hub /
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

(Vv VWYYV YT Y

Properties g X
» Sequential Logic
> Signal Name Value Type
> User Input
» Vector Operations

Console 8 X

'l ¥ 59 y:-95 zoom: 1
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[E] Algo Builder GUI - * - 0 x
File Edit \ Firmware Tools Help

AR A eaaaaloc BEX I STL & Py -

Library &F X Description g X
> Comparison
» Constants
v Display
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int)
Graphics
Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID

MotionMC -

MationPW [Sensor Hub] 3| GEEEELT »| Graph1

Other [o]

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]

Magnetc Fes (1T Drag and drop [Sensor Hub], Acceleration and

Pressure [hPa]

(Vv VWYYV YT Y

 seqventmoge Graph 1 function blocks to the workspace. Eii = =
> Signa ame alue ype

> ager}nput

» Vector Operations

Console 8 X

'l ¥ -354 y:-301 zoom: 1
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[E] AlgeBuilder GUIF
File Edit View

Rl

Library

Filter: |

Tools  Help

F RARQAQQ| S

Iﬁ

X |

[T Th &%

X

° # D: NODE_L476RG ~ m =) IEI

» Comparison

» Constants

w Display
Bar
Fusion
Graph
Histogram
Logic Analyzer
Plot3D
Scatter
Value

Graphics

Lagic Operators

Math Operations

Motion AW

MaotionFx

MotionGC

MationID

MaotionMC

MotionPW

Other

Sensor Hub
[Sensor Hub]
Acceleration [a]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]

Sequential Logic

Signal

Temperature

User Input

Vector Operations

Vv VvV VYV Y YV

VW W W W

[Sensor Hub] F

Y

Acceleration

[d]

1. Selects Graph

| Graph

2. Set properties

- O X
Description F X
Graph =
Version: 2.0

Graph. Displays up to six reaktime curves. The X-axis

represents time, Y-axis is value.

Input Pins:
in (variant x 3):

Input data to plot (y-axis value). The input data size

has to match with number of curves.

Properties:
MHumber of Curves (int):

Defines number of curves to plot. Value must be from

1to6.

Range: <1, 6>
Graph Name (string):

Label of the graph.
Waveform 1 Name (string):

Name of the waveform 1.
Waveform 2 Name (string):

Name of the waveform 2.
Waveform 3 Name (string):

Name of the waveform 3.
Waveform 4 Name (string):

Name of the waveform 4.
Waveform 5 Name (string):

£ [

-

Console

R £ 4k
Properties [
Na_r_ne Value Type
Murnber of Curves 3 INT
Graph Name Acceleration STRING
Waveform 1 Name X axis STRING
Waveform 2 Name Y axis STRING
d Waveform 3 Name Z axis STRING
Unit Name [al STRING
Zaro axis position Middle ENUM
Auto-scale ON ENUM
Full Scale 1 STRING
—

' l ¥ 266 y:-292 zoom: 1
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[E] Algo Builder GUI - * - 0 x
File Edit View Firmware Tools Help

d AR o BEX T SATL e L JIET VTR < JHES

Library &F X Description g X
> Comparison
» Constants
v Display
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int)
Graphics
Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID

MationMC -
MotionPW [Sensor Hub] Mcdmhm[ : Graph 1
Other g

Sensor Hub
[Sensor Hub]

pecoletin (6] Connect function blocks.
agnet b FuT] (Click on output and hold left mouse button,
Pressure [hPa]

Temperature [+ move to the input and release) Propertis 5 x

Sequential Logic
Signal Name Value Type
User Input

ector Operations

(Vv VWYYV YT Y

S Y

Console 8 X

'l ¥ 474 y: 68 zoom: 1
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8] Algo Builder GUI - * - O x
File — Edit gud Firmware Tools  Help
O] L 7 —
GEP feacaaloc BRX AT % L ICel] - e
Library & X Description g X
» Comparison = = 113 7
oans Save the design to default path with name “MyExample_1.xml
v Display -
Graph 1
Graph 2
Logic Analyzer = .
Save Design X
Value (Float)
N Gra:r?ilgse (Int) < > Miroslav BATEK » STMicroelectronics » AlgoBuilder » Designs v O Search Designs o
) -
. :;:;ilhc gg:rr:;ci?}r:s Organize New folder Bz - (7]
i :ogon,:xw " MName Date modified Type Size
otian 5+ Quick access
> MotionGC [ Exampled1_Demoaml 6/4/2018 9:08 AM XML File 44 KB
> MotionID B Desktop
S MotionMC a Example02_FreeFall.xml 6/4/2018 9:08 AM XML File 40 KB
S MotionPW ¥ Downloads [ ExampleD3_Tilt_Messurementaxml 6/4/2018 %08 AM XML File 30 KE
> Other Documents [&f Exampled4_Filtersaml 6/4/20189:08 AM XML File 21 KB
v Se”*?c‘” Hub . [&] Pictures [&f ExampleD5_Feature_Computation.xml 6/4/2018 %:08 AM XML File 23KE
Sensor Hub
Accemmtion -[g] AlgoBuilder DT ExampleD6_ZeroCrossing_PeakDetectorsx..  6/4/2072 8:02 AM XML File 52 KB
Angular Rate [dps] Designs DT Examplel7_Algorithms_Integration.xml 6/4/2018 9:08 AM XML File A0 KB
Humidity [percent] . Example02_6D_Detection.xml 6/4/20189:08 AM XML File 3TKE
Magnetic Field [uT] SW_AlgoBuilder o preseen ) o )
Pressure [hPa] Weekly 2018 DT Example08_60_Detection_v2xml 41772018 3:23 PM XML File 39 KB
(==
Temperatu!'e [=C] Y g ExampleD8_Tilt_Using_Gyro.xml 5/21/2018 &57 AM XML File 23 KB Properties 8 x
> Seq“f”tﬁ" Logic [ This PC [ MyExample_1.xml 6/9/2018 1257 AM XML File 7KB — Value Trpe
> Signa T P "
> User Input [ Desktop DT MyExarmple_2.ml 6/9/2018 1:02 AM XML File 22 KB
> Vector Operations Documents [&f MyBxample_3xml §/9/2018 1:18AM  XMLFile 28Ke
MyEx le_d.xml /8/2018 1:27 AM XML Fil 16 KB
‘ Downloads Ej{ yEEmple.fam o e
J! Music
[&] Pictures hd
File name: | MyExample_1.xml -
— Save as type: | *xml ~ | E
o 3
~ Hide Folders Swve | Cancel

life.augmented



[E] Algo Builder GUI - MyExample_1.xml - O x
File Edit \ Firmware Tools Help

A A acaa@ eoc B Xl I__.lm9 8 o - B E
Library 5 X =
» Comparison

; Gonsans 1. Click on Generate C code
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int)

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MationMC -
MotionPW [Sensor Hub] MCE[IE']M:" Graph 1
Other g

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal MName Value Type

User Input

ector Operations

Description g X

(Vv VWYYV YT Y

Properties g X

S Y

I--'iﬁiﬁilﬂ & X

Code generation finished successfully.

LY

2. Check if the code was generated successfully

'l ¥ 465 y: -269 zoom: 1
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[E] Algo Builder GUI - MyExample_1.xml - O x

File Edit nware  Tools

View  Firrr Help

q AR A aaaaec BEX | AITL e 8 otrond - K

Library &F X Description g X

> Comparison .

_ Gonsants 1. Click on Show C code
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int)

Graphics

Logic Operators E algo_builder.c - Notepad H 1 o = X

Math Operations | _ 2. See the generated algo_builder.c file

MotionAW/ File Edit Fermat View Help -

Eﬁﬂﬁﬂz’é I#:'anlude "algo builder.h"

MotionID

MotionMC . * .
MotionB\s void *Nodel;

Other float Mode2[3];

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Humidity [percent] yoid AB_Init(void)
Magnetic Field [uT)| -
Pressure [hPa) {

(Vv VWYYV YT Y

Temperature [°C] Sensor_Hub Init({l@e, 1, 1); 5 x
i :_eq“?”tia' Logic Graphl_Set(3); Type
Iigna
5 Ufermput Graphl Set Mames(“"Acceleration”™, "X axis™, "Y axsi", "Z axis", "Waveform 4", "Waveform 5", "Waveform &", "[g]");
> Vector Operations 1

void AB Handler{woid)

i
Sensor_Hub Handler(&MNodel);
Accelero_Sensor_GetData(Model, Node2);
Graphl_Update(Node2);

1

'l ¥ 340 y:-294 zoom: 1

life.augmented




[E] Algo Builder GUI - MyExample_1.xml

File Edit nware  Tools

Library

Help

AEAB A eaaaloc b Xl

F X

| 71 s wl_o

O o - b E

> Comparison

» Constants

v Display
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int)

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPW

Other

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal

User Input

ector Operations

(Vv VWYYV YT Y

S Y

=

1. Click on Build Firmware

Graph 1

2. Wait for compilation
3. Check that the code was compiled without error

Generating binary:

Exit Code: 0

X
N
arm-none-eabi-objcopy -0 binary "STM32L4x¢-Mucleo-Project.el™ "STM32L4e-Nucleo-Project.bin” & arm-none-eabisize —format=berkeley STM32L4:0-Nucleo-Project.eff
text data bss dec hex filename
169984 T672 46628 224284 36clc STM32L4xx-Nucleo-Project.elf
19:34:17 Build Finished (took 7m:23s.656ms)
Invoking scanner config builder on project
Build Process Finished J

x
Description g X
Properties g X
MName Value Type

" ¥ 60 y:-282 zoom: 1
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[E] Algo Builder GUI - MyExample_1.xml - O x

File Edit View Firmware Tools Help
THELE QA@loec bl Xl ITTh| {5 #E:NODE_H?ERG' [ i [E3)
Library &F X  — Description g X

> Comparison

$ oy 1. Connect STM32 Nucleo to your PC 4. Open Unicleo-GUI

Graph 1
Graph 2 .
Logc Aryee 2. Click on Program STM32 Nucleo
alue (Floa
Value (Int)
Graphics
Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID

MationMC -
MotionPW [Sensor Hub] MCE[IE']M:" Graph 1
Other g

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal MName Value Type

User Input

ector Operations

(Vv VWYYV YT Y

Properties g X

S Y

Console 8 X
text data bss dec hex filename
169984 7672 46628 224284 3eclc STM32L4xx-Nucleo-Project.elf

19:34:17 Build Finished (took 7m:23s.656ms)
Invoking scanner config buider on project
Build Process Finished

[E‘Efé%%’:é’#‘%§5°gﬁizzi=5§$;e§iﬂ¥‘m one: p:none Le7es | 3. VWait till the board is programmed |

L
" ¥ 260 y: -277 zoom: 1
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1. Check the boards is connected to Unicleo GUI

k4 Unicleo-GUI

Select Device: JCOM6 o # Connect w‘ Disconnect | v Start Stop | .2 Settings | 2 Exit

Info FW Management User Messages IKS01A2 Options

oa 2. Click Start to run the application

-

Acceleration

3. Open| data visualization

£
€
be
4
£
£
4
[ 4
€
£
£
£

o W[4 [§=

X
 IEXXXXEXRXXXX)

STMicroelectronics Unideo Version: 1.4.5.6406 Firmware Version = 5.0.0 Expansion Board: IKS01A2

Lys

life.augmented



1. Test the functionality.

Ed Unicleo-GUI
Select Device: [COMS Connect ¥ Disconnect Start
Info FWW Management User Messages Ik501A2 Options
I_l Time Stamp|icceleration [[gll |
Datalog |¥ axis 1Y axis |2 axis |
2:29: 1| 0.00&000] -0.0140001 1.020000]
2 12-29:12_ 57| 0.00&000] -0.013000] 1.021000] 1[g]
Acceleration 12-:25:12 58| 0.00&000] -0.014000] 1.022000]
12:29:12_59| 0.007000] -0.013000] 1.023000]
12:29:12.60]| 0.007000] -0.013000] 1.023000] W]
12-:25:12 81| 0.00&000] -0.013000] 1.024000]
12:-25:1z2._82| 0.0080001 -0.0130001 1.024000]
12:29:12_ 63| 0.007000] -0.0140001 1.023000]
12:29:12 64| 0.007000] -0.014000] 1.023000]
12-:25:12 5| 0.007000] -0.013000] 1.022000]
12:29:12_ 66| 0.005000] -0.013000] 1.021000]
12:29:12_&67| 0.00&000] -0.013000] 1.021000]
12-25:12 88| 0.007000] -0.013000] 1.023000]
12:-25:12._859| 0.0070001 —-0.0140001 1.022000]
12:29:12_70| 0.008000] -0.015000] 1.017000]
12-29:12_ 71| 0.005000] -0.014000] 1.035000]
12-:25:12 72| 0.004000] -0.012000] 1.025000]
12:29:12_73| 0.008000] -0.013000] 1.01&8000]
2:29:12.74| 0.008000] -0.013000] 1.018000]
2:29:12 75| 0.004000] -0.012000] 1.028000]
2:25:12_7¢l 0.0070001 —-0.0140001 1.023000]|
12:29:12_77| 0.008000] -0.014000] 1.019000]
12-29:-12_78| 0.005000] -0.013000] 1.028000]
12-:25:12 79| 0.00&000] -0.012000] 1.022000]
12:29:12_80| 0.007000] -0.013000] 1.013000]
12:29:12_81| 0.007000] -0.015000] 1.021000] nsg) il ] <+— Autoscale
12-:25:12 82| 0.00&000] -0.013000] 1.025000]
12.23.12_83| 0_007000 | ~0.013000] 1.022000| - | E == 2=
12:29:12_84| 0.007000] -0.012000] 1.022000]
STMicroelectronics Unideo Version: 1.4.5.6406 Firmware Version = 5.0.0 Expansion Board: IKS01A2

,’ 2. Close Unicleo-GUI when you finished the testing.
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[[[[[

Acceleration
[a]

Demo 2
Impact Detection

Input Value




Impact Detection ... Evaluate if magnitude of acceleration is above given

threshold for certain time.

Acceleration
Magnitude
[a]

A

Impact
Threshold

Lys
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Algo Builder GUI* - O x
9

git  View Firmware Tools

h;@ﬁae\”@\@\ coBEXI-STL %% Yl v

i 28 Description 5 X

Comparisan

Constants 1 H
= Click on New Design
Graphics

Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID
MotionMC
MotionPW

Other

Sensor Hub
Sequential Logic
Signal

User Input
Vector Operations

WOWOW WOV W W W W W W W W W W W W

Properties g X

MName Value Type

Console 8 X

'l ¥ -119 y: 134 zoom: 1
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[E] Algo Builder GUIF
Fle Edit View Firm

vare  Tools  Help

| 7 O o - b E

— | % "C 'O

O e

(B BB A aaaaoc Bl Xl
Library & X
Comparisan
Constants
Display
Graphics
Logic Operators
Math Operations
MotionAW
MotionFX

MotionGC
MotionID
MotionMC
MotionPW
Other

[E] Firmware Settings

Firmware Location

ot

1. Browse for C:\AlgoBuiIder\MyExampIe_2 dir

Sensor Hub

|C:fAIgoBuilderfMyExample_Z

|| Browse |

Sequential Logic

Signal Toolchain / IDE

WOWOW WOV W W W W W W W W W W W W

User Input
SW4STM32

Vector Operations
Target

- 2. Select compiler SW4STM32

NUCLEO-L476RG

"| | OK || Cancel |

3. Select Target NUCLEO-L476RG

4. Click OK

Console

x
Description g X
ectory
Properties g X
MName Value Type

'l ¥ -119 y: 134 zoom: 1
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[E] Algo Builder GUI - *
File Edit View

0 @f’

Library

T Help

RAQAQ o b E X

F X

| 7 O o - b E

— | % “C "0

Comparisan

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPW

Other

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal

User Input

Vector Operations

(W VYVYYVYVYVYYY YWYV

WO W N

1. Place [Sensor Hub] to workspace

[Sensor Hub] F

2. Change Accelerometer Full Scale to 8g

- O x
Description g X
[Sensor Hub]
Version: 1.0

Sensor Hub provides links to sensor and algorithms in order
to retrieve data from them.

Qutput Pins:
out (void x 1):
Sensor Hub handler.

Properties:
Data Rate (int):
Defines the sensor's and algorithm's data rate in Hz.
Range: <1, 400>
Accelerometer Full Scale (int):
Defines the accelerometer full scale.
Values: 2g,44g, 84,160
Gyroscope Full Scale (int):
Defines the gyroscope full scale.
Values: 245 dps, 500 dps, 1000 dps, 2000 dps

Console

Properties g X

MName Value Type
Data Rate 100 INT

P Accelerometer Full.. |8 g ~ |ENUM
Gyroscope Full Scale | 500 dps ~ [ENUM

" ¥ 481 y:-302 zoom: 1
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[E] Algo Builder GUI - *

File Edit View Firmware

Library

Tools  Help

F X

Comparisan

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPW

Other

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal

User Input

Vector Operations

(W VYVYYVYVYVYYY YWYV

WO W N

A

HOR A aaqaieoc BEX 5 2T L

% C o

O o - b E

dd Acceleration [g] function block

[Sensar Hub] F—D

Acceleration
[a]

Description

Acceleration [g]
Version: 1.0
Retrieve the accelerometer data.

Input Pins:
SensorHubHandle (void x 1):
Connect to Sensor Hub output.

Output Pins:
data (float x 3):

Accelerometer data (acceleration) in g unit.

Properties

Console

Name Value

Type

" ¥ 60 y:-292 zoom: 1
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[E] AlgoBuilder GUI - * - O X

File Edit View Firmware T Help
O L gl 7 — . N
OB M aaa@ v Xl |1 | '] & ¢ o £ o:vovererers - B & [E
Library 8 X Description g X
Filcer: | | X Graph =l
> Comparison Version: 2.0
» Constants Graph. Displays up to six reaktime curves. The X-axis
v Display represents time, Y-axis is value.
Bar. Input Pins:
Fusion in (variant x 3):
Graph Input data to plot (y-axis value). The input data size
Histogram . has to match with number of curves.
Logic A
Logc Analzer 1. Add Graph function block broperties
Scatter Murmber of Curves (int):
Defines number of curves to plot. Value must be from
Value 1to6.
» Graphics Graph Range: <1, 6>
» Logic Operators Graph Name (string):
» Math Operations Lab;eJ of the graprE. )
> MotionAW Waveform 1 Name (string): e
> MotionFX [Sensor Hub] Acceleration 3 . CO nn eCt Name of the waveform 1.
> MotionGC [a] Waveform 2 Name (string):
] Name of the waveform 2.
» MotionID Waveform 3 Name (string):
» MotionMC Name of the waveform 3.
> MotionPW Waveform 4 Name (string):
» Other Name of the waveform 4.
> Sensor Hub Waveform 5 Name (string): -
B £ b £ | =
» Sequential Logic
> Signal Properties g X
» Temperature Name Value Type
» Userlnput Number of Curves 3 INT
» Vector Operations Graph Name Acceleration STRING
Waveform 1 Name X axis STRING
Waveform 2 Name Y axis STRING
H — VWaveform 3 Name Z axis STRING
2. Set propertles Unit Name [al STRING
Zero axis position Middle | ENUM
Auto-scale On ~ | ENUM
_Full Scale 4 STRING

Console g X

" x:-18 y:-293 zoom: 1
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Algo Builder GUI - * - O x
9

File Edit View rmware  Tools  Help
u Y ’ —

N AR aa@ e BEXIE SITL % 8 otrond - K
Library B X Description g X
> Comparison Magnitude
> Constants Version: 1.0
» DLSDI?]‘J’ Calculates magnidude of the input vector.
» Graphics
> Logic Operators Input Pins:
> Math Operations in (float x 3):
S MotionAw Input vector.
> MotionFX

. Output Pins:
> MotionGC out (float x 1):
> MotionID Magnitude.
> MaotionMC
> MotionPW
> Other Graph 1
» Sensor Hub
> Sequential Logic
> Signal
> User Input . [Sensor Hub] Acceleration Magn'rtudeF
v Vector Operations I [d]

Magnitude

Normalize

Properties g X
MName Value Type

Console 8 X

'l ¥ 173 y: -278 zoom: 1
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Console

[E] Algo Builder GUI - * - 0 x
File Edit View Firmwar T Help
I AR & aaa@ i oc hEX = o7 8 otrond - K

£ | IO [} — |} % =S¢ =&
Library &F X Description g x
~ Comparisan Greater than (=)

Equal to (=) Version: 1.0

Greater than (=) Checks if in1 is greater than in2. Returns 1 if the condition

Greater than or equal to (>=) is true, 0 otherwise.

Less than (<)

Less than or equal to (<=) Input Pins:

Not equal to (1=) |n|1:_(5\£anantxé):
» Constants __irst operand.

) in2 (varantx 1):
> Display second operand.
> Graphics
> Logic Operators Output Pins:
» Math Operations out (intx 1):
> MotionAW Graph 1 Resuft.
> MotionFX
> MotionGC
> MotionID -
> MotionMC [Sensor Hub] P—D Acceleration Magnitude F— »
> MotionPW d] o >
> Other
> Sensor Hub
» Sequential Logic .
sl Add Greater than (>) function block
> User Inpu
» Vector Operations
Properties g x
MName Value Type

" ¥ 204 y: -299 zoom: 1
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Algo Builder GUI - * - O x
9

File Edit View Firmware T Help
O Y ’ J—
a9 AR M aQaq ioc XI5 ST L g & ot Found i+ JE3)
Library &F X Description g X
> Comparison Input Value (Float) 1=
> Constants Version: 1.0
? DLSD'?]Y get up to four float values from Unicleo-GUT
» Graphics
> Logic Operators Qutput Pins:
> Math Operations out (float x 1)
S MotionAw Output data.
> MotionFX -
. Properties:
> MotionGC Nurmber of Values (int):
> MotionID Defines number of values. Value must be from 1 to 4.
> MaotionMC Range: <1, 4=
> MotionPW Default Value 1 (float):
> Other Graph 1 Defines default value 1.
" Hub Default Value 2 (float):
5 S:nizrnti:I Logic Defines default value 2.
ed g Default Value 3 (float):
> Signal e Defines default value 2.
v User Input [Sensor Hub] P—b [l Magnitude F — > Default Value 4 (float):
Input Value (Binary) d » > Defines default value 4.
Input Value (Float) Value 1 Name (string):
| Label of the value 1.
Input Valug (Int) / Value 2 Name (string):
? Vector Operations / Label of the value 2
) .
| 3 . CO n n eCt Value 3 Name (string):
Label of the value 3. —
Input Value |/ Value 4 Name (string): .
(Float) Lahel nf the valis 4
Properties g X
1. Add Input Value (Float) function block Name Vae Type
Number of Values 1 INT
Default Value 1 7 FLOAT
Default Value 2 ] FLOAT
. Default Value 3 0 FLOAT
2. Set proper“es J Defaultvalue4 0 FLOAT
Value 1 Name Impact Threshold [g] STRING
Value 2 Name Value 2 STRING
Value 3 Name Value 3 STRING
Value 4 Name Value 4 STRING
-

Console 8 X

'l ¥ 236 y: -302 zoom: 1
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Algo Builder GUI - * - O x
9

File Edit View Firmware T Help
O b / o8
N AR aa@ e BEXIE SITL % 8 otrond - K
Library 8 X Description g X
> Comparison Pulse Width
> Constants Version: 1.0
> DLSDI?]‘; Measures pulse width.
» Graphics
> Logic Operators _Input Pins:
> Math Operations in (int x ].‘):
S MotionAW Input signal.
> MotionFx
. Output Pins:
> Mot!onGC out (intx 1):
> MotionID Pulse width in ms unit.
> MaotionMC
> MotionPW Properties:
S Other Graph 1 . . Level (int):
> Sensor Hub Ad d PU IS e WI dt h fU n Ct ion b I ocC k Seﬁne.aﬁtwetl_evelpoffthe pulse to measure.
> Sequential Logic alies: legative, Fostive
~ Signal 5
Derivator [Sensor Hub] F—b Acce{;r]ahnn Magnitude F — Pulse
Feature Computation » P width
FIR Fiter
Gain [
TIR Filter {
Integrator {
Moving Average
Peak Detector Inputl Value
Pulse Generator ( )
Pulse Width Properties g X
Signal Delay

MName Value Type

Zero Crossing
> User Input Level ENUM

» Vector Operations

Console 8 X

" ¥ 286 y: -289 zoom: 1
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[E] Algo Builder GUI - *

File Edit View Firmware

Library

Tools  Help

H AR Aaaaq o X

F X

v Comparison
Equal to (=)
Greater than (=)
Greater than or equal to (==)
Less than (<)
Less than or equal to (<=)
Mot equal to (1=)

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPwW

Other

Sensor Hub

Sequential Logic

Signal

User Input

Vector Operations

WOWOW WOV W W W W W W W W W W Y Y

| T L % %% € oo - B E
Add Greater than or equal
ot to (>=) function block
[Sensor Hub] F—b Mce{;']aﬁ"" Magnitude F—: R F N - F

Description

Greater than or equal to (>=)

Version: 1.0

Checks if in1 is greater or egual than in2. Returns 1 if the
condition is true, 0 otherwise.

Input Pins:

inl (variant x 1)
First operand.

in2 (varantx 1):
Second operand.

Output Pins:
out (intx 1):
Result.

Properties

Console

MName Value Type

" 207 y: -267 zoom: 1
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[E] AlgoBuilder GUI - * - O X
File —Edit View Firmware Tools Help
u (O / T — : A
OB M aaa@ v Xl |1 | '] & ¢ o £ o:vovererers - B & [E
Library 8 X Description g X
Fiter: | | x Input Value (Int) =)
> Comparison Version: 2.0 )
» Constants Get up to eight integer values from Unicleo-GUL
’ DGDE“.' QOutput Pins:
? GmPh'Cs out (int x 1):
» Logic Operators Output data.
» Math Operations
> Motion AW Properties:
> MotionFX W?_raow]cfﬁme (_stéringk
> MotianGC e of the window.
X Mﬁt:gng Murnber of Values (int):
) Defines number of values. Value must be from 1 to 8.
# MotionMC Graph Range: <1, 8>
> MotionPW Default Value 1 (int): |
» Other Defines default value 1.
» Sensor Hub Deﬁ;lt Vaéu%zéint?:
» Seguential Logic Acceleration . Defines default value 2.
> Signal [Sensor Hub] [a] Magnitude P>+ _p| Pule Iaq Default Value 3 (int):
o Temperature e Width (0 Defines default value 3.
- UserpInput Default Value 4 (int):
| Defines default value 4.
Input Value (Binary) Input Value |~ Input Value Default Value 5 (int):
Input Value (Float) (Float) (Int) 3. Connect Defines default value 5.
Input Value (Int) Default Value 6 (int):
> Vector Operations Defines default value 6. -
=P = T N 3 e
H Properties [
1. Add Input Value (Int) function block
Mame Value Type
Window Name Duration STRING
. Number of Values 1 INT
2. Set properties |[{ oefukvaver 10 wr
Value 1 Name Impact Duration [ms] STRING
Console g X
" x: 211 y:-284 zoom: 1
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[E] Algo Builder GUI - *
File Edit View Firmware

| HEIEIP

aaaaloc il

% C o

O o - b E

F X

> Comparison

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPW

Other

Sensor Hub

Sequential Logic

Signal
Derivator
Feature Computation
FIR Filter
Gain
TIR Filter
Integrator
Moving Average
Peak Detector
Pulse Generator
Pulse Width
Signal Delay
Zero Crossing

> User Input

» Vector Operations

AV VYV Y Y Y Y

[Sensor Hub] P—b ""c‘*{‘;’]‘_’“""

o

I F_: > F —» \I:::db; F_/_/: = F ) Ge?‘liftor
1. Add Pulse Gf
e o vae function block

2. Set Width to 1000 —

Description

Pulse Generator
Version: 1.0
Generate pulse with defined width.

Input Pins:
in (int®1):
Trigger signal.

Output Pins:
out (int x 1):
Qutput signal.

Properties:

width (int):
Define the width of the pulse in ms unit.
Value must be greater than or equal to: 0

2nerator

Properties

Value
1000

Name
Width

Console

Type
INT

" ¥ 461 y:-258 zoom: 1

life.augmented




[E] AlgoBuilder GUI - * - O X
File Edit View Firmware Tools Help
O TR 7 -_ . N
OB M aaa@ v Xl | ] | '] & ¢ o £ o:vovererers - B & [E
Library 8 X Description g X
Fiter: | | x Logic Analyzer =3
> Comparison Version: 2.0
> Constants Displays up to eight logic values in real-time chart. The
v Display X-axis represents time, Y-axis is logic state (0 or 1).
E’ar_ d d : | Input Pins:
usion in (intx1):
Graph 1' A I—Og IC An a yzer Input data to display (y-axis value). The input data size
Histogram . has to match with number of channels.
Logie Anchze function block roperte
Plot3D -
Snoztter MNumber of Channels (int):
Value Logic Defines number of channels to plot. Value must be
— from 1 to 8.
> Graphics R 3. Connect 7| _anabzer Range: <1, 16> .
» Logic Operators \\M Logic Analyzer Mame (string):
» Math Operations ~ r:.abe.-llof the Iog(ic anar)yzer.
> MotionAW Acceleration : ) \ Channel 1 Mame (string):
. MotionFX [Sensor Hub] + > [al Magnitude F > - —p| Pule I5g - F _p|  Pulse F—) Label of the channel 1.
" MotionGe > Width (D Generator Channel 2 Name (string):
. Label of the channel 2.
> MotionID | Channel 3 Name (string):
> MotionMC Input Value | Input Value Label of the channel 3.
> MotionPW (Float) {Int}) Channel 4 Name (string):
» Other Label of the channel 4.
% Sensor Hub Cr]arlmfl E‘r_\lkameL (strinlgg: =
» Sequential Logic = - o
> Signal JLUENNES
» Temperature MName Value Type
i 'L«Jt'secrt I”F::;Jt . . Mumber of Channels 1 INT
actor Operations i i
2. Set p ro pert'es Logic Analyzer Name Logic##Analyzer STRING
Channel 1 Name Impact STRING
Console g X
" x: -10 y:-239 zoom: 1

life.augmented



8 AlgoBuilder GUI - *
File  Edit

Library
Fitter: |

Tools  Help

FAQQ Q| w

I

X |

%® C ©

£ o:noververs - b &

>
>

Comparison
Constants

~ Display

VWV WV VY VY VWY VWY VY

Bar

Fusion

Graph

Histogram

Logic Analyzer

Plot3D

Scatter

Value
Graphics
Logic Operators
Math Operations
Maotion AW
MationFX
MaotionGC
MationID
MationMC
MationPW
Other
Sensor Hub
Sequential Logic
Signal
Temperature
User Input
Vector Operations

the design to default path with name “MyExample_2.xml”

[%] Save Design

— O x
Description H X
Logic Analyzer (=)
Version: 2.0

Displays up to eight logic values in reaktime chart. The
¥-axis represents time, Y-axis is logic state (0 or 1).

Input Pins:

in (intx1):
Input data to display (y-axis value). The input data size
has to match with number of channels.

Properties:

Mumber of Channels (int):
Defines number of channels to plot. Value must be
from 1 to 8.

Range: <1, 16>

Logic Analyzer Mame (string):
Label of the logic analyzer.

Channel 1 Name (string):
Label of the channel 1.

Channel 2 Name (string):
Label of the channel 2.

Channel 3 Name (string):
Label of the channel 3.

Channel 4 Name (string):
Label of the channel 4.

4 » Miroslay BATEK » STMicroglectronics » AlgoBuilder » Designs v O Search Designs
Organize + MNew folder B -
~ MName Date modified Type Size
5 Quick access .
M Example01_Demeo.axml 7/9/2018 2:39 PM XML File 55KE
[ Desktop » - -
Example02_FreeFallxml 7/9/2018 2:39 PM XML File 56 KB
& Downloads [&f Exampled3_Tilt_Measurement.xml 7/9/20182:39PM XML File 43KB
Documents [ Exampled_Filters.cml 7/8/2018 239 PM XML File 23KB
[&] Pictures - Q{ Example03_Feature_Computation.xml 7/9/2018 2:39 PM XML File 31KB
Designs Q{ Example06_ZeroCrossing_PeakDetector.x.., 9/2018 2:39 PM XML File 62 KB
Documentation Q{ Exarnpled7_Algorithms_Integration.xml 9/2018 2:39 PM XML File 51 KB
SW_AlgoBuilder [ Example08_6D_Detection.xml /2018 2:39 PM XML File 43 KB
- Example09_Tilt_Using_Gyro.xml 8/20/2018 2:43PM XML File 28 KB
K-CUBE-MEMS-, oy )
[ Example10_FFT.xml 8/23/20183:00PM XML File 45KB
3 This PC (& MyExample_1xml 8/28/201812:35PM XML File S9KE
[ Desktop Q{ MyExample_2xml 8/28/2018 10:47 AM XML File 38 KB
Documents [ MyExample_3xml 8/28/2018 10:534 AM XML File 25KB
- .
MyExample_4.xml 8/28/2018 10:4% AM XML Fil 20KE
* Downloads M yE@mpletam o - e
Jﬂ Music
[&] Pictures v
File name: | MyExample_2xml
Save as type: | *xml
 Hide Folders Cancel

Channel 5 Name (string): -
Lmbnol of bl b =
Properties -
MNamea Value Type
Hurnber of Channels 1 INT
Logic Analyzer Name Logic##Analyzer STRING
Channel 1 Name Impact STRING

> /4
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File

Library
Fitter: |

[E] AlgoBuilder GUI - MyExample_2xml

Edit WView Firmware Tools Help

SHEIEIP A NS HONORIR

ERIRar Y [1

£ o:voverrers - b & [E

g X
%

>
>
W

VWV WV VY VY VWY VWY VY

Comparison
Constants
Display
Bar
Fusion
Graph
Histogram
Logic Analyzer
Plot3D
Scatter
Value
Graphics
Logic Operators
Math Operations

L

1. Click on Build Firmware

Graph

Maotion AW
MationFX

Acceleration

Logic

™ Analyzer

N
e

-

[d]

A 4

MaotionGC
MationID
MationMC
MationPW
Other

Sensor Hub
Sequential Logic
Signal
Temperature
User Input
Vector Operations

Magnitude} - . F
'b

Pulse
Generator

Pulse
Width

s

i
Y
v

Input Value
(Float)

2. Wait for compilation
3. Check that the code was compiled without error

g

Input Value
(Int}

— O X
Description H X
Logic Analyzer (=)
Version: 2.0

Displays up to eight logic values in reaktime chart. The
¥-axis represents time, Y-axis is logic state (0 or 1).

Input Pins:

in (intx1):
Input data to display (y-axis value). The input data size
has to match with number of channels.

Properties:

Mumber of Channels (int):
Defines number of channels to plot. Value must be
from 1 to 8.

Range: <1, 16>

Logic Analyzer Mame (string):
Label of the logic analyzer.

Channel 1 Name (string):
Label of the channel 1.

Channel 2 Name (string):
Label of the channel 2.

Channel 3 Name (string):
Label of the channel 3.

Channel 4 Name (string):
Label of the channel 4.

Console

—
arm-none-eahi-objcopy -0 binary "STM32L4xx-Nucleo-Project.elf” "STM32L4xx-Nucleo-Project.bin” & arm-none-eabi-sze -format=berkeley STM32L4x0e-Nucleo-

Project.elf
text
169464

data
5752

bss
46632

13:27:24 Build Finished (took 45.583ms)
Invoking scanner config builder on project
Build Process Finished

Exit Code: 0

hex filename

36208

dec
221848

STM32L4xx-Nucleo-Project.elf

ol

Channel 5 Name (string): -
Lmbnol of bl b =
Properties -
MNamea Value Type
Hurnber of Channels 1 INT
Logic Analyzer Name Logic##Analyzer STRING
Channel 1 Name Impact STRING

> /4

¥ =70 y:-285 zoom: 1
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[E] AlgoBuilder GUI - MyExample_2xml - O *

G ERB S acaaoc BMX ISt TL = %% @ Jroewe <[ | @

Library & X e Description 5 X
Fiter: | X . Logic Analyzer =)
> Comparison - Version: 2.0
> Compareo 1. Connect STM32 Nucleo to your PC 4. Open Unicleo-GUI ||tesen 20 @ @ s i reasteme chart. The
v Display ¥-axis represents time, Y-axis is logic state (0 or 1).
B 2. Click on Program STM32 Nucleo tnput pins:
Graph Input data to display (y-axis value). The input data size
Histogram has to match with number of channels.
Logic Analyzer .
Plot3D Properties: .
Scatter Murmber of Channels (int):
Value Logic Defines number of channels to plot. Value must be
e from 1 to 8.
> Graphics Graph G Analyzer R;Ze: <01, 16> :
» Logic Operators \"a Logic Analyzer Mame (string):
» Math Operations \\ Label of the logic analyzer.
> Motion AW Acceleration . ) \ Channel 1 Name (string):
% MotianFX [Sensor Hub] + » [al Magnitude F g S _p| Puke isq F —p| Pule F) Label of the channel 1.
» MotionGC - Width (D Generator Channel 2 Name (string):
j Label of the channel 2.
# MotionID | Channel 3 Name (string):
> MotionMC Input Value | - Input Value Label of the channel 3.
> MotionPW (Float) (Int) Channel 4 Name (string):
» Other Label of the channel 4.
> Sensor Hub Channel 5 Name (string): -
> Sequential Logic ;
> Signal Properties T X
» Temperature Name Value Type
» Userlnput Mumber of Channels 1 INT
» Vector Operations Logic Analyzer Name LogicEZAnalyzer STRING
Channel 1 Name Impact STRING
Console g X
text data bss dec hex filename -
169464 5752 46632 221848 36208 STM32L4x¢-Nucleo-Project.elf
13:27:24 Build Finished (took 45.583ms)
Invoking scanner config builder on project
Build Process Finished
i do.
FW binary file programed successfully! 3 W H H | I h b d H d
IDE: 5W4STM32 Target: STM32L476RG Drive: D: MODE_L476RG . alt t I t e O ar IS p rO g ram m e —

L
' l X 286 y:-285 zoom: 1
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1. Check the boards is connected to Unicleo GUI

=
Datalog

k4 Unicleo-GUI -

Logic
Analyzer

Acceleration

Threshold

Duration

3. Oper

1 all windows

Select Device: ICOMG ! r ,l # Connect g“ Disconnect | v Start Stop | .2 Settings | X Exit

Info FW Management User Messages IKS01A2 Options

2. Click Start to run the application

£ 3
£ 3
£ L 3
£ 3
£ 3
£ 3
£ 3
c 3
c 3
£ 3
c 3
£ 3

X xxx]
es000000000000

STMicroelectronics Unicleo Version: 1.4.5.6406 Firmware Version = 5.0.0 Expansion Board: IKS01A2




> /4

augmented

1. Test the functionality.

B Acceleration

10 [g]

5[]

|

- Logic Analyzer

Impact

Ed Unicleo-GUI
Select Device: [COMS Connect ¥ Disconnect | Start
Info FWW Management User Messages Ik501A2 Options
|_| Time Stamp|Lo|Rcceleration [[gll |
Datalog I LIX axis 1Y axis 12 axis |
o 123:32:10.55] 0| 0.0&0000| 0.023000] 1.025000]
B 13:33:10.57| 0| 0.033000] 0.033000] 1._006000]
Logic 13:33:10.57| 0| 0.042000] 0.021000] 1.018000]
Analyzer 13:33:10_58| 0| 0.04Z000| 0.028000] 1.036000]
123:323:10.59| 0] 0.048000| 0.031000] 1.051000]
2 13:33:-10.60] O] 0.044000 | 0.033000] 1.070000]
Acceleration 13:83:-10.621 0Ol 0.048000| 0.030000] 1.074000]1
123:33:10.82| 0| 0.044000] 0.017000] 1.045000]
] 13:33:10.64| 0| 0.049000 | 0.003000] 1.005000]
Thres_hcld 13:33:16'%%' ol 0.040000 | _G'GHMGI 0_9?3ﬂﬂﬂ|
1%:33:10.66| 0| 0.040000| -0.028000| 0.983000]
13:323:10.66| O] 0.043000] -0.018000] 0.952000]
= 13:33:-10.67| O] 0.026000| -0.014000] 0.870000]
Duration 13:33:10.881 0Ol 0.024000| -0.002000] 0.3850001
123:323:10.69| 0| 0.030000| 0.000000] 1.001000]
13:33:10.71| 0| 0.040000 | -0.001000] 1.040000]
13:33:10.71| 0| 0.044000] 0.000000] 1.071000]
1%:3%:10.73| 0| 0.033000] 0.004000] 1.084000]
13:33:10.73| 0| 0.039000| 0.013000] 1.062000]
13:33:-10.75] 0| 0.045000 | 0.007000] 1.052000]
13:33:10.751 0Ol 0.035000| 0.008000] 1.0430001
123:323:10.76| O] 0.032000] 0.021000] 1.007000]
13:33:10.771 0| 0.016000] 0.011000] 0.972000]
13:33:10.78| 0| 0.002000] 0.008000] 0.861000]
1%:3%:10.80] 0| 0.008000| 0.017000] 0.951000]
13:33:10.80] O] 0.011000] 0.030000] 1.013000]
13:33:-10.82| 0| 0.015000] 0.03&000] 1_068000]
13:33:10.82] 0Ol 0.022000| 0.033000] 1.081000]
13:32:10.83| 0| 0.021000] 0.027000] 1.045000]
STMicroelectronics Unicleo Version: 1.4.5.6406

| Threshold

Impact Threshold [g] |?

Exp

~| Duration

Impact Duration [ms] |ll]

2. Close Unicleo-GUI when you finished the testing.
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Demo 3
FFT Analysis

A FFT
Graph / E \_..

[Sensor Hub]

Acceleration
[a]

Mux [5]
(Float)

Value




Algo Builder GUI* - O x
9

git  View Firmware Tools

h;@ﬁae\”@\@\ coBEXI-STL %% Yl v

i 28 Description 5 X

Comparisan

Constants 1 H
= Click on New Design
Graphics

Logic Operators
Math Operations
MotionAW
MotionFX
MotionGC
MotionID
MotionMC
MotionPW

Other

Sensor Hub
Sequential Logic
Signal

User Input
Vector Operations

WOWOW WOV W W W W W W W W W W W W

Properties g X

MName Value Type

Console 8 X

'l ¥ -119 y: 134 zoom: 1

life.augmented



Algo Builder GUI™ - O X
9
File Edit Vie Firmware Tools Help

B BB A eaaaoc BRXIEATLE sk Py -

Library &F X Description g X

Comparisan

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID %

MotionMC . H q H

Mo rmware oaton L. Browse for C:\AlgoBuilder\MyExample 38 directory
er

Sensor Hub |C:fAIgoBuilderfMyExample_Z | | Browse |

Sequential Logic

Signal Toolchain / IDE

Vector Operatins SWasTM32 -] 2. Select compiler SWA4STM32

Target

[E] Firmware Settings *

WOWOW WOV W W W W W W W W W W W W

NUCLEO-L476RG -] | ok || Cancel |

3. Select Target NUCLEO-L476RG 4. Click OK

Properties g X

MName Value Type

Console 8 X

'l ¥ -119 y: 134 zoom: 1
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[E] Algo Builder GUI - *
File  Edit

e

Library

nware  Tools  Help

K aaag oc Xl

F X

— & c e & ot Found ] = =2

Comparisan

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPW

Other

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal

User Input

Vector Operations

(W VYVYYVYVYVYYY YWYV

WO W N

1. Place [Sensor Hub] to workspace

[Sensor Hub] F

2. Change Accelerometer Full Scale to 4g
3. Output Data Rate ODR 100Hz

- O x
Description g X
[Sensor Hub]
Version: 1.0

Sensor Hub provides links to sensor and algorithms in order
to retrieve data from them.

Qutput Pins:
out (void x 1):
Sensor Hub handler.

Properties:
Data Rate (int):
Defines the sensor's and algorithm's data rate in Hz.
Range: <1, 400>
Accelerometer Full Scale (int):
Defines the accelerometer full scale.
Values: 2g,44g, 84,160
Gyroscope Full Scale (int):
Defines the gyroscope full scale.
Values: 245 dps, 500 dps, 1000 dps, 2000 dps

Properties =
MName Value Type
Data Rate Control Timer * ENUM
P Data Rate 100 INT
Accelerometer Full 5c... 4g + ENUM
Gyroscope Full Scale 500 dps + ENUM

Console

'l ¥ 481 y:-302 zoom: 1
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[E] Algo Builder GUI - *

File Edit View Firmware

Library

Tools  Help

F X

Comparisan

Constants

Display

Graphics

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MotionPW

Other

Sensor Hub
[Sensor Hub]
Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa)
Temperature [°C]

Sequential Logic

Signal

User Input

Vector Operations

(W VYVYYVYVYVYYY YWYV

WO W N

A

HOR A aaqaieoc BEX 5 2T L

% C o

O o - b E

dd Acceleration [g] function block

[Sensar Hub] F—D

Acceleration
[a]

Description

Acceleration [g]
Version: 1.0
Retrieve the accelerometer data.

Input Pins:
SensorHubHandle (void x 1):
Connect to Sensor Hub output.

Output Pins:
data (float x 3):

Accelerometer data (acceleration) in g unit.

Properties

Console

Name Value

Type

" ¥ 60 y:-292 zoom: 1
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[E] AlgoBuilder GUI - * - O X

File Edit View Firmware T Help
O L gl 7 — . N
OB M aaa@ v Xl |1 | '] & ¢ o £ o:vovererers - B & [E
Library 8 X Description g X
Filcer: | | X Graph =l
> Comparison Version: 2.0
» Constants Graph. Displays up to six reaktime curves. The X-axis
v Display represents time, Y-axis is value.
Bar. Input Pins:
Fusion in (variant x 3):
Graph Input data to plot (y-axis value). The input data size
Histogram . has to match with number of curves.
Logic A
Logc Analzer 1. Add Graph function block broperties
Scatter Murmber of Curves (int):
Defines number of curves to plot. Value must be from
Value 1to6.
» Graphics Graph Range: <1, 6>
» Logic Operators Graph Name (string):
» Math Operations Lab;eJ of the graprE. )
> MotionAW Waveform 1 Name (string): e
> MotionFX [Sensor Hub] Acceleration 3 . CO nn eCt Name of the waveform 1.
> MotionGC [a] Waveform 2 Name (string):
] Name of the waveform 2.
» MotionID Waveform 3 Name (string):
» MotionMC Name of the waveform 3.
> MotionPW Waveform 4 Name (string):
» Other Name of the waveform 4.
> Sensor Hub Waveform 5 Name (string): -
B £ b £ | =
» Sequential Logic
> Signal Properties g X
» Temperature Name Value Type
» Userlnput Number of Curves 3 INT
» Vector Operations Graph Name Acceleration STRING
Waveform 1 Name X axis STRING
Waveform 2 Name Y axis STRING
H — VWaveform 3 Name Z axis STRING
2. Set propertles Unit Name [al STRING
Zero axis position Middle | ENUM
Auto-scale On ~ | ENUM
_Full Scale 4 STRING

Console g X

" x:-18 y:-293 zoom: 1
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File Edit Wiew Firmware Tools Help

AR L ocBRXISTT L+ QQAQQ @cle Bhees -l e &

Library Description T X
Filter: X 100
I Buffers Demux (Float)
[ Comparison Version: 1.0
[ Constants Float demultiplexer. Creates individual scalar outputs from input array.
[» Display
Input Pins:
4 FFT in1 {float x 3):
FFT Input.
FFT Peak Detector
[» Graphics Qutput Pins:
[» Library Mame ouél {ﬂoiiix 1):
[» Logic Operators outén{?i:atlx 1:
[» Math Operations B . Output 2. '
1. Add Demux Float function block from the Other Library | es6o
[> MotionFX Output 3.
[ MotionGC
[ MotionID Properties:
I+ MotionMC ::;nb:r :?Lism;m (int):
> MotionPW 08: <&
[» Other
I Pressure Gfﬂﬂ"l
[> Sensor Hub
[» Sequential Logic
[» Signal
[+ Temperature
[+ User Input
[ Wector Operations

< F » Acceleration Demuzx [3]
I [ l—Lb] I-g] {Hoat} Properties 5 X

MName Value Type
MName Value Type
Mumber of outputs 3 INT

2. Set properties 3 outputs
3. Connect

Console 5 X

Lys
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File Edit Wiew Firmware Tools Help

DA L oc bl Xl

Library

Filter:

X

[T TL= @QQAQ| g cle Bhees -l e &

I» Buffers
[ Comparison
[» Constants
[» Display
4 FFT

FFT

FFT Peak Detector
Graphics
Library Mame
Logic Operators
Math Operations
MotionAwW
MotionFX
MotionGC
MotionID
MotionMC
MotionPW
Other
Pressure
Sensor Hub
Sequential Logic
Signal
Temperature
User Input
Vector Operations

TV R WY YN YRV YTV YT WV

Description F X

FFT
Version: 1.0
This block collects data into buffer and if buffer is full computes FFT.

Input Pins:
in (float x 1):
Input data.

Qutput Pins:
out (float x 512):
Qutput in the frequency domain.
size {intx 1):
Buffer Size.
full {int x 1):
Buffer full flag. Returns 1if the buffer is full, 0 otherwise.

Properties:
Data length (float):
Values: 32, 64, 128, 256, 512, 1024
Window Type (int):
Values: Mone, Hanning, Hamming, Flat Top

1. Add 3x FFT function block from the FFT Library
=] LT
Graph
I [Sensor Hub] H Aceseration e l. FFT
2. Set propexr\‘tixes 256 data length
-
3. Connect

Properties [
MName Value Type
Data length 256 - ENUM
Window Type Mone +* ENUM

Lys

life.augmented

101




Library
Filter:

File Edit View Firmware Tools

DA L oc bl Xl

]QaQq

T re— RN

I» Buffers
[ Comparison
[» Constants
[» Display
4 FFT

FFT

FFT Peak Detector
[» Graphics
[» Library Mame
[» Logic Operators
[» Math Operations
[» MotionAW
[» MotionFX
[ MotionGC
[» MotionID
[» MotionMC
[» MotionPW
[» Other
[» Pressure
[> Sensor Hub
[» Sequential Logic
[» Signal
[+ Temperature
[+ User Input
[ Wector Operations

1. Add 3x FFT Plot function block from the Display Library

e p—

2. Set properties 256 o\l“‘at‘a length & Full Scale 1

FFT Plot
> =0

3. Connect

Acceleration
[a]

FFT Plot
P FFT

Description

FFT Plot
Version: 2.0
Displays FFT plot.

Input Pins:
in (float x 512):
Inputin the frequency domain.

Properties:

Plot Mame (string):
Label of the plot,
Data length (float):
Values: 32, 64, 128, 256, 512, 1024

Lnits (string):

Vertical axis units.

Auto-scale (int):
Auto-scale enabled.
Values: OFF, OM

Full Scale (string):

Console

Plot full scale.

Properties

MName Value Type
Plot Name 7 axes STRING
Data length 256 * ENUM
Units STRING
Auto-scale OFF ¥ ENUM
Full Scale 1 STRING

Lys
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File Edit Wiew Firmware Tools Help

DA L oc bl Xl

[T TL= @QQAQ| g cle Bhees -l e &

2. Set properties 256 data length

3. Connect

FFT Peak I

Properties [
FFT Flat MName Value Type
Data length 256 » ENUM
Exdude DC NO * ENUM

Console

Lys

life.augmented

Library Description & X
Filter: X 1 O 3
I Buffers FFT Peak Detector
[ Comparison Version: 1.0
I> Constants This block detects maximum amplitude in the frequency spectrum.
[» Display
4 FFT Input Pins:
jl 1. Add 3x FFT PEAK f block from the FFT Lib "k data
AT pesk Detector . X unction bloc rom the iorary Input datz,
[» Graphics
. Output Pins:
[+ Libw I,
b LI riiré arr;:m amplitude (float x 1):
b Mogm Ope i Maximum amplitude in the frequency spectrum,
ath Lperations frequency (float x 1):
E :"E"”"Z‘XW Frequency with the maximum amplitude.
otionl ==
[ MotionGC Plot Properties:
[> MotionID Graph Data length (float):
I MotionMC values: 32, 64, 128, 256, 512, 1024
[> MotionPW FFT Peak Exdude DC (int):
[» Other Exclude DC component from maximum amplitude evaluation.
> Pressure Values: NO, YES
[> Sensor Hub /
[» Sequential Logic i Plo
[» Signal . ' t
b Temperature [Sensor Hub] Acceleration Demux [3]
[+ User Input I-f-'] (Hoat}
[ Wector Operations ", -
N FFT Peak




Library
Filter: X

File Edit Wiew Firmware Tools Help

[T TL= @QQAQ| g cle Bhees -l e &

DA L oc bl Xl

[

[
[
[
4

TV R WY YN YRV YTV YT WV

Buffers
Comparison
Constants
Display

T o 1. Add MUX float function block from the Other Library

Graphics

Library Mame
Logic Operators
Math Operations
MotionAwW
MotionFX
MotionGC
MotionID
MotionMC

MotionPW

Pressure Graph ; Vs

Sensor Hub S .,
Sequential Logic ;/ FFT Peak ,

Signal r .
Temperature e AN

User Input yd et oot \\\\
Vector Operations Acceleration Demux [3] \\\\

[Sensar Hub] F—'. al (Float) > FFT ‘\\‘F

™, FFT Peak I ¥

Mux [8]
(Float)

2. Set properties 6 inputs

3. Connect

Description

Mux (Float)
Version: 1.0
Float multiplexer. Creates array from scalar inputs.

Input Pins:

inl (float x 1):
Input 1.

in2 (float x 1):
Input 2.

in3 (float x 1):
Input 3.

in4 (float x 1):
Input 4.

in5 (float x 1):
Input 5.

ing (float x 1):
Input &,

Output Pins:
out (float x 6):
Output.

Properties:
Mumber of inputs (int):
Range: <2, 16>

Properties

Console

MName Value Type

Number of inputs &

Lys
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€] AlgoBuilder GUI -

File Edit Wiew Firmware Tools Help
O R / T iy -
OO KX oc B@XIl==l+Th RAQAA g ce O erers - bl & E
Library g X Description [
Filter: X Value
I» Buffers Version: 2.0
I Comparison Displays up to eight integer values.
[» Constants
N Input Pins:
> Display in (variant x 8):
4 FFT . . Input data to display. The input data size has to match with
ja 1. Add MUX fl f block from the Other Lib b of ks
P Pesk Detector . oat tunction block trom the Other Library
N Properties:
» Graphlcs Mumber of Values {int):
4 ler.ary Name Defines number of values to display. Value must be from 1 to 3.
[» Logic Operators Range: <1, 8>
[» Math Operations Window Mame (string):
> MotionAw Label of the values window.
X Value 1 Name (string):
" Moh.oan Label of the value 1.
> MotionGC Value 2 Name (string):
[» MotionID Label of the value 2.
[ MotionMC Value 3 Name (string):
[ MotionPW FFT Plot Label of the value 3.
 Other E FFT Value 4 Name (string):
- Graph e Label of the value 4.
TEssUre A Value 5MName (string):
I Sensor Hub / FFT Peak t Label of the value 5.
[» Sequential Logic s Value 6 Name (string):
I Signal Label of the value 6.
b T i v Value 7 Name (string):
emperature | X . FFT Plot Label of the value 7.
I User Input ) [Sensor Hub] Acceleration Dthg:ﬂ » FFT Value 8 Name (string):
[ Vector Operations | [a] {Floa Label of the value 8.
N, - Unit 1 Mame (string):
\ FFT Peak - Mux [6] Unit of the value 1.
‘\‘ (Float) p—> Value
N | Properties & X
A . i FFT Plot I Mame Value Type
> FFT Number of Values 3 INT
- Window Name Values STRING
i | Value 1 Name X STRING
Value 2 Name ¥peak STRING
. Value 3 Name Y STRING
2. Set properties 6 values and the labels Vake dName ¥ pesk STRONG
Value 5 Mame Zpeak STRIMNG
Value & Name z STRING
Unit 1 Name Unit 1 STRING
3 CO nn eCt Unit 2 Name Unit 2 STRING
" Unit 3 Name Unit 3 STRING
Unit 4 Mame Unit 4 STRING
Console & X | Unit 5 Name Unit 5 STRING
Unit & Mame Unit & STRING

> /4
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[-E] AlgoBuilder GUI -

(=]

File Edit View Firmware

HEAB KA e X

Library

Filter:

QRaQa &%

# :NODE_L4TERG ™ H EI

4 |ibrary Mame
Function Block Name

Logic Operators

Math Operations

MotionAW

MotionFX

MotionGC

MotionID

MotionMC

MationPW

Other
Counter
Demux (Float)
Demux (Int)
Feedback (Float)
Feedback {Int)
Float To Int
Int To Float
Mux (Float)
Mux (Int)
Switch {Float)
Switch {Int)

[+ Pressure

4 Sensor Hub

[

Acceleration [g]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [*C]
Timestamp [ms]
4 Sequential Logic
Set-Reset Flip Flop
4 Signal
Derivator
Feature Computation
FIR Filter
Gain
IIR. Filter
Integrator
Moving Average
Peak Detector
Pulse Generator
Pulse Width
Signal Delay
Zero Crossing
4 Temperature
Celsius to Fahrenheit
Fahrenheit to Celsius
4 ser Input
Input Value (Binary)
Input Value (Float)
Input Value (Int)
4 Vector Operations
Magnitude
Normalize

1.-Connect STM32 Nucleo to your PC
Click on Program STM32 Nucleo

4. Open Unicleo-GUI

:Ei:{ —
>
Graph

[Sensor Hub]

Acceleration

m

FFT
Demux [3] ]
(Hoat)E i E :

Mux [8]
(Float) P—> Value

Console

Generating binary:

text data
230632 5776

Build Process Finished
Coio o

make —no-print-directory post-build

] dec
71536 357944

22:26:18 Build Finished (took 45s.439ms)
Invoking scanner config builder on project
ISESSION 2018-10-25 22:25:22,445

hex
57638

arm-none-eabi-objcopy -0 binary "STM32L4xx-Nudeo-Project. elf” "STM32L4xx-Nudeo-Praject. bin™ & arm-none-eabi-size --format=berkeley STM32L4xx-Mucleo-Project. elf
b

filename
STM32L 4ox-Nudeo-Praoject. elf

F binary file programed successfully!

IDE: SW4STM32 Target: STM32L476RG Drive: D: NODE_L475RG

3. Wait till the board is programmed

Description =]
Properties 9 »
Name Value T

4

M

x: 213 y: 494 zoom: 1




1. Check the boards is connected to Unicleo GUI

»” Disconnect | . Stop | 2 Settings | X Exit

lilnfo I FW Management I User Messages ‘ IKS01A2 Options |

2. Click Start to run the application

¥
MU MMM YN

3. Open datla visualization

Xl
0000000000000 59

Unidleo Version: 1.4.10.6689

Firmware Version = 5.0.0 Expansion Board: IKS01A2

Lys
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1. Test the functionality.

2. Remove the DC
3. Move the board
4. FFT , check the peak and frequency

Ed Unicleo-GUI

Select Port: T Connect Disconn

Info FW Management User Messages

2 Graph

m
[

Time Stamp|Values
|Value 1 [Unit 1|Value Z [Unit

22:04:31.94| -25 -0000a0
23:-04:32_01]| 92 _25 _0ocoao
23:04:32.08] 92.25 -00000
23:-04:-32.18| 92 _25 -0000a0
23:04:32.24| 92_25 -0000a0
23:-04:32_31]| 92 _25 _0ocoao
3:04:32.39] 92.25 -00000

23:-04:-32_48| 9z
22:04:32.54| 9z
223:-:04:32 _ 61| 8z
23:04:32.69] 9z
23-04:-32_78| 9z

[

-0000a0 Output Data Rate: 100 Magnitude: 500 m

w

[

afatululil
noooo A | ! FFT Samples: 1024 Display Mode: Bars
-ooooo (ECEEER 1

2 || E DC Nullin = =
R | . | 9

[}

[

23:04:32.683| 52.25 -0 0 || B
23:04:32_31| 5z -00000 / = [o [lx

23:04:32.99] 92.25 .00000

22:04:33.06| 92.25 .00000

23:04:33.14| 52.25 WLLLL - mplitude [m ampitude: Amplifude [m]

23:04:33 21| 5225 -00000

2:04:33.29] 92.25 .00000

22:04:33.36| 92.25 .00000 Peak and
23:04:33.44| 52.25 .00000

23:-04:33.51| az._
223:04:33.58]1 9z.
23:04:33. 88| 3
23:04:33.74| 3
23:-04:33_.81| 3
223:04:33.89| 3
Port: COM79 Closed

[

00000 a0 frequency

-00000
-0000a0
-0000a0
_0ocoao
-00000

oo

[

[ IS IS [ I IS s I B I IS S IS IS S B IS IS [ I I S [ R I I e |
B IR BEE B B JEESS ESS RS IS IS IS IR B NESS EESS RSN IS BESS B B B IS I B B B B |
LI L T U R VU L R PRI /L L VL LI L LI L Lt L U O TR U R
[ s o e N e e e e O O e e = ]

[}

B3 R3 BR3 R ORD R B3 ORY ORI ORD R RD RS RY BRI R R R ORI ORI R RE R R RD RRD
[
W W w w0 w W w W Wil W w W w W

| 4 I Output Data Rate: Magnitude: 500 m Output Data Rate: Magnitude: 500 m
FFT Samples: Display Mode: Bars FFT Samples: Display Mode: Bars F FT

Shicodectonis L M oC nulling oo DC Nulling

> /4
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ST MEMS complete software solution

From drivers to software development tools

Low-level Drivers

Standard C Platform
Independent drivers

Windows drivers

Linux drivers

Development Tool
based on Low level
drivers

Runs on STM32

Sample implementation
of device embedded
features

IEHE

;
l
§

Go to st.com

Generic SW libraries

Accuracy, Calibration,
Positioning, Activity tracking,
Health monitoring

Dedicated SW libraries

v
OO

Q60

AlgoBuilder Tool

Dedicated software
Tool for libraries
development

Graphical design apps to
build and use algorithms

Go to ST.com



https://www.st.com/content/st_com/en/products/embedded-software/mcus-embedded-software/stm32-embedded-software/stm32cube-expansion-packages/x-cube-mems-xt1.html
http://www.st.com/content/ccc/fragment/product_related/rpn_information/board_photo/group0/0d/fe/7e/8b/3d/b5/4f/cc/X-CUBE-MEMS-XT1 image/files/x-cube-mems-xt1_image.jpg/_jcr_content/translations/en.x-cube-mems-xt1_image.jpg
https://www.st.com/content/st_com/en/products/embedded-software/mems-and-sensors-software/inemo-engine-software-libraries/algobuilder.html
https://www.st.com/content/st_com/en/products/embedded-software/mems-and-sensors-software.html
https://www.st.com/content/st_com/en/products/embedded-software/mems-and-sensors-software/open-mems.html?querycriteria=productId=SC1998

Takeaways

Internet of Things offers many opportunities for ST
from Sensor to Cloud

ST has all the building blocks for the loT

« MEMS and Analog portfolio from consumer to industrial
applications

« AlgoBuilder allows fast proof of concept of Sensor based
algorithms

We keep the commitment on MEMS innovation @L‘ ﬁj

Our constantly expanding development ecosystem
makes design fast

Lys
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ST Community — Mass Market Support

All Places > MEMS apd.Semsors Community . |
MEMS and Sensors Forum Folowing~ ~ Actions~ = @ | @~

Activity Content People Subspaces Reports

CATEGORIES

All content (1075) [ Blog Posts (0) B Documents (4) & Discussions (11) B Questions (1062) ¥ videos (0)
MEMS Microphones

Mass Market Support: MEMS Forum

For more information on sensors: Www.st.com/sensors

Information on longevity: 10yr Longevity Program

Android / Linux / Open Drivers: Drivers for MEMS

life.augmented


http://www.st.com/content/st_com/en/products/mems-and-sensors.html?icmp=tt5748_gl_bn_sep2017
http://www.st.com/content/st_com/en/support/resources/product-longevity.html
http://www.st.com/content/st_com/en/extended-query.html?querycriteria=productId=SC1885$$associatedTo=FM89
https://community.st.com/community/mems-sensors-community/mems-sensors-forum
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